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Trademarks
AnyView, AnyView Browser and AnyView Creator are trademarks of Accountable Software,
(Datcuity, Inc.).
Microsoft Dynamics is a trademark of Microsoft Corporation in the United States and/or other
countries.

Other company or product names mentioned may be trademarks or registered
trademarks of their respective holders.
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Documentation Files
When AnyView Browser or AnyView Creator are installed, several Documentation files are installed, Links
to these files are installed in Start -> Programs -> Accountable Software – AnyView.
Whats New in AnyView (2013).pdf – A summary of the newest features in AnyView.
AnyView Browser (2013).pdf – Description of Installation and use of AnyView Browser.
AnyView Creator (2013).pdf -- Description of Installation and use of AnyView Creator.
AnyView Upgrade (2013).pdf – Steps for upgrading to the latest AnyView Build or Version
AnyView_Tutorial.chm – Examples of real-world use of AnyView features.

Before you Install
Before beginning the AnyView Browser installation, it is important to read and understand the
requirements detailed in this document.

Configuration Options
AnyView can be installed in several different configurations. Two such configurations are listed below:

Single Server Installation
In a single server installation, all necessary components are installed on a single machine. An example of
this type of installation would be a demo machine such as a laptop computer where all of the required
components are installed on the single machine.
These are the components installed on the single machine:


Windows 2000 or Windows XP, or Windows Server 2000/2003/2008 with Internet Service
Manager (ISM/IIS) and Classic 32 bit .asp enabled.



Microsoft SQL Server 7.0 or higher



Microsoft Dynamics™ GP 2013 RTM or higher



Dexterity 11.00mxx or higher



Smartlist 11.00.x or higher



AnyView System and IIS/ ISM Components



AnyView IIS Virtual Directory Web Pages



DSNs connecting to the Microsoft Dynamics™ GP databases

When using the AnyView installation program ANYVIEW COMPLETE (2013) BUILD 96.EXE, to install on a
single machine, the installation option: AnyView – All Server and Client Components should be selected.
See the Installing AnyView Browser section of this document.

A NYV IEW

Page 8 of 132

Accountable Software.

Multiple Server Installation
Several types of multiple server configurations exist. Listed below are 2 examples of possible variations.

1. IIS and Database Server on the Same Machine
If this machine has a local Microsoft Dynamics™ GP client installation, then the AnyView installation
option: AnyView – All Server and Client Components should be selected during the install. This option
will install the code for the local Microsoft Dynamics™ GP client install, and the web pages and files
required for AnyView Browser.
If this machine does not have a local Microsoft Dynamics™ GP client install, then the AnyView
Browser Web Server installation option should be used. This option creates the AnyView Virtual
directory and installs the web pages and files used by AnyView Browser.
Additional workstations should be configured using the AnyView Creator and Browser Client
Components option of the install.

Installed Components
Microsoft SQL Server 2012 - Microsoft SQL Server 2008 R2, SP 1 or later
AnyView – All Server and Client Components =or= AnyView Browser Web Server.

Additional Components
AnyView IIS Web Application – Created by the install or manually created.
DSN connecting to the Microsoft Dynamics™ GP database – see ODBC Setup.

2. IIS and Database Server on Separate Machines

IIS Server
When the IIS Server and the Database Server are separate machines, the AnyView Browser Web
Server installation option should be selected for the IIS Server, provided that no Microsoft Dynamics™
GP client is installed. This option creates the AnyView Virtual directory and installs the web pages and
files used by AnyView Browser.
Installed Components:
Microsoft SQL Server 2012 - Microsoft SQL Server 2008 R2, SP 1 or later
AnyView – All Server and Client Components =or= AnyView Browser Web Server.
Additional Components:
AnyView IIS Web Application – Created by the install or manually created.
DSN connecting to the Microsoft Dynamics™ GP database – see ODBC Setup.

DB Server
If the Database Server has a local Microsoft Dynamics™ GP client installation, the AnyView Creator and
Browser Client Components should be installed. If no local client is installed, there is no installation
required for the Database Server.

Installed Components:
Microsoft SQL Server 2012 - Microsoft SQL Server 2008 R2, SP 1 or later

Optional Components for either Server: (If a Microsoft Dynamics™ GP client is
installed)
Microsoft Dynamics™ GP 2013 RTM or higher
Dexterity Runtime 13.00mxx or higher
Microsoft Dynamics™ GP SmartList 13.00.x or higher
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AnyView Creator and Browser Client Components
DSN connecting to the Microsoft Dynamics™ GP database – see ODBC Setup.

System Requirements
AnyView Browser Client
•

Microsoft Internet Explorer 8.0 or higher

Microsoft Dynamics™ GP Client
•

Microsoft Dynamics™ GP, version 2013 RTM or higher

•

Dexterity Runtime version 13.00mxx or higher

•

SmartList 13.00.x or higher

Windows 2000 Server / Windows 2000 Professional / Windows XP / Windows
Server 2003 / Windows Server 2008
•

AnyView version 2013 (13.00.XX)

•

Internet Service Manager

•

ActiveX Data Objects (ADO) 2.5 or higher

•

Internet Explorer 5.0 or greater

•

Service Pack 1 for Windows 2000 is required, (Latest Service pack recommended.)

Before installing AnyView Browser on Windows 2000 / Windows XP /Windows Server 2003/2008, it is
important to install and configure the Server with the IIS / Internet Service Manager Option. And enable
32 bit “Classic” .asp
Follow the Microsoft recommended system requirements for installation and system configuration.
ActiveX Data Objects 2.5 will be installed with AnyView Browser.
Microsoft Dynamics™ GP 2013 RTM or higher must be installed on the server containing the Microsoft
Dynamics™ GP database.
Installation of the correct ODBC driver is also critical. Follow all of the Database Requirements and ODBC
setup steps as outlined in the ODBC Setup section of this manual.

Database Requirements
Microsoft SQL Server
Microsoft SQL Server 7.0 or higher, SQL Server 2000, SP3 or higher recommended.
SQL Server ODBC Driver version 3.7X.XX.XX or higher.
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Installing AnyView Browser
The installation of AnyView Browser is a four-step process:

1. Install AnyView Browser code files.
2. Create The Virtual Directory, set its properties
3. Include the new code in Great Plains
4. Initialize AnyView Tables and Stored Procedures

** Important Setup Information **
It is highly recommended that you download the latest version of AnyView from our web site:
www.accountable.com prior to installation.

1. Install AnyView code files.


Insert the Accountable Software CD into the CD-ROM drive or launch the application downloaded
from our website.



The setup program should start as soon as you insert the CD into the drive. If it does not launch
automatically, then it may be started manually by selecting Start » Run from the Windows
Taskbar and selecting the application CDSETUP on the CD.



If using the web site download, find the ANYVIEW COMPLETE (2013) BUILD XX.EXE file that was
downloaded, and double click it to run the setup.

The Main InstallShield Wizard for AnyView installation window opens.


Click Next >.

Wait while the AnyView installation routine extracts the files needed for the installation.
The installation program begins with the AnyView Setup window.


Click NEXT >.

Review the license agreement, and confirm your acceptance to the terms described within.


Click YES.



Review the important installation information. Be sure to follow all of the recommended setup
steps.



Click Next >.
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On the SELECT TYPE window, choose the applicable setup type.


AnyView – All Server and Client Components: Installs the AnyView Browser web server and
AnyView Browser and Creator client components.



AnyView Creator and Browser Client Components: Installs the client components for all of the
AnyView products. (needed on each Microsoft Dynamics™ GP Workstation for either AnyView
Creator or AnyView Browser)



AnyView – Web Server Components Only: Installs only the files used by the IIS Web server



Custom: Allows you to select AnyView components for installation.

If you choose Custom, the Select Components window appears. Select which components to install:
Note that the Custom Option is not typically needed, and if used, will remove components that were
previously installed if they are not selected.
• AnyView

Server System Files: Installs the web server files necessary to run AnyView,
including the web application files.

• AnyView
• MDAC:

Browser Web Server: Installs the web pages for use with AnyView Browser.

Installs the Microsoft Data Access Components 2.5 required on the web server.

• AnyView

Documentation: Installs the AnyView installation, configuration, and user
documentation in the Microsoft Dynamics™ GP directory.

• AnyView

Creator & Server Admin: Installs the AnyView Creator and AnyView Browser Server
Administration Dictionary Code and the components it depends on, for use with Microsoft
Dynamics™ GP. This code is combined in one file, and is installed for either AnyView
Browser or AnyView Creator.

• AnyView

Browser Documentation: Installs the AnyView installation, configuration, and user
documentation in the AnyView Browser directory.



Click NEXT >.

If you elected to install AnyView Browser components during this installation, the ANYVIEW BROWSER
DIRECTORY screen will appear. Specify the physical directory in which the AnyView installation routine
should create the files needed for the Web Server.


Accept the default path, or choose BROWSE and either type a path name or browse to an existing
path.



Click NEXT >.

If you elected to install AnyView Creator components during this installation, the MICROSOFT
DYNAMICS™ GP DIRECTORY screen will appear. Specify the folder where the Microsoft Dynamics™
GP application is installed. This folder is typically located on your local hard drive.
Important: The installation routine may default the installation to “C:\ Dynamics” or “C:\
eEnterprise”. If this is not the location where Microsoft Dynamics™ GP is installed on your
machine, you will need to specify the correct directory.


Verify that it is the correct directory, or use the BROWSE button to select the location of the
desired version of Microsoft Dynamics™ GP.



Click NEXT >.
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The installation routine will then begin to copy all files to the appropriate directories. The InstallShield
Wizard Completed window opens when installation is done.
1. Enter the Virtual Directory Name
If installing AnyView Server Components, you will be presented with the AnyView Web Application
Name window. If you are installing a new instance of AnyView, enter the name of the Web Application
you would like to create.
If installing an upgrade to an existing AnyView install, enter the name of your existing AnyView Web
Application. If you did not unload your AnyView Web Application(s) prior to installation, you will be
asked to restart your system. You will be given the option to restart on your own or have InstallShield
restart for you.


Click Finish.

2. Include the new code into Microsoft Dynamics™ GP.
If you are installing the AnyView Creator and Server Administrator, you will need to complete the
following steps to have Microsoft Dynamics™ GP “include” the code.


Start Microsoft Dynamics™ GP.

You will see a prompt asking you if you want to include the new AnyView code, as shown in the
following illustration.



Click YES.

A progress bar will display, while the “unchunking” process is executing.
This installation step accomplishes the following two tasks:


The DYNAMICS.SET file will be modified to include the information required to run AnyView.



A dictionary named “AV2377.DIC” will be created in your Microsoft Dynamics™ GP folder.

This concludes the generic AnyView installation process. See the following sections for Database and
feature specific installation steps.
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3. Creation of Microsoft SQL Server Objects – Tables and Stored Procedures
When starting Microsoft Dynamics™ GP for the first time after installing AnyView, you must log into the
Application as the system administrator (sa or Dynsa or a user in the fixed sysadmin role ) in order to
complete the installation process.
When starting Microsoft Dynamics™ GP, you may be presented with the following prompt:
AnyView needs to be initialized by the system administrator or access has not been granted
to AnyView tables. Would you like to proceed with initialization now?
Select YES to create the required SQL tables and stored procedures.
This process does not destroy any data; it simply creates objects in SQL Server and grants access to all
users to these objects.
This process may take some time to complete and will report a completion status of successful or
unsuccessful. If you received an unsuccessful message, try the process again.
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Synchronizing AnyView Tables
After installing AnyView Browser, you will get a message that reads:
"The AnyView Utilities Process needs to run in order to use AnyView.
Do you want to run the process now?”
If you answer “Yes”, the synchronization process will run.
The synchronization is complete when all of the status boxes have been updated to Completed and the
Process button is enabled. You can then proceed to the registration process.

AnyView Utilities Window.

To view data from any third party application, this initialization step must be performed after the third party
application is installed.

Synchronize Logins
The SYNCHRONIZE LOGINS button is used only if you have AnyView Browser installed, and you are utilizing
the External Logins Functionality of AnyView Browser. The purpose of the Synchronize Logins button is to
run a ‘Check Links’ style verification on the records in the Internet Address table and the AnyView Login
tables. Any discrepancies found will be corrected and reported on the AnyView Login Errors Report when
the process finishes. An example of a discrepancy that would be corrected by the synchronize process is
orphaned records in the AnyView login tables. Should a record exist in the AnyView User Master table that
does not exist in the Internet Information table, this process would remove that record.
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Installation for External Tables
If AnyView Creator users plan to use External Tables in their objects, there are a few additional setup
steps required.
The AnyView External Tables Setup screen, run at a client machine from within Microsoft Dynamics™ GP,
uses Microsoft’s Distributed Component Object Model (DCOM) to fetch valid DSNs, databases, tables,
and fields from the AnyView web server. This ensures that all DSNs, databases, tables, and fields
managed by AnyView External Tables Setup at the client machine are accessible from the AnyView web
server.
The additional steps required to accommodate this functionality are related to setting up DCOM correctly.
When an implementer installs the AnyView web server components, the DCOM component called
ASIPROXY.DLL is installed and registered in Windows. Security Permissions, however, need to be
established manually using the Windows DCOM configuration utility, DCOMCNFG.

Note: This step is not required if the Creator client and web server are the same
machine; such as a demonstration machine.

Installation Steps
1. In Windows, on the AnyView web server, click the Start button, then Run, then type DCOMCNFG:

Figure 1. Running DCOMCNFG.
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2. Scroll down or type ahead in the Applications list until you find ASIPROXY.CLASS1.

Figure 2. DCOM properties.

Click on ASIPROXY.CLASS1, then click the PROPERTIES button.
Note, on the Windows XP and Windows 2003 operating systems, DCOM Configuration has been
incorporated into The Component Management console, so instead of picking ASIProxy.Class1 in the
window above, one must navigate to it in the console, and choose View -> Properties, as shown below.
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On the ASIPROXY.CLASS1 PROPERTIES windows, click the SECURITY Tab.

Figure 4. ASIPROXY.DLL Properties, Security tab.

3. Click the USE CUSTOM ACCESS PERMISSIONS and USE CUSTOM LAUNCH PERMISSIONS radio buttons.
4. Click the EDIT button for each, and add the users or groups who will need to run AnyView External
Tables Setup.

Figure 3. Setting DCOM permissions.
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5. Choose the IDENTITY tab, and set the user account to either LAUNCHING USER, or a specific user.
LAUNCHING USER will typically suffice.

Figure 4. ASIPROXY.CLASS1 Properties, Identity tab.

6. Click OK to save the configuration.
7. You may need to restart the machine for the DCOM security changes to take effect, and allow
remote machines to use the ASIProxy object to list DSN’s
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Registering the Software
By registering your copy of AnyView, you will enable us to keep you informed of all enhancements,
improvements, and upgrades for the software. By communicating with you we can gather information
about additional Microsoft Dynamics™ GP enhancements that will work towards Enhancing The
Experience.
Software registration can also eliminate unauthorized use of software without imposing restrictive copy
protection.
Registration keys are provided by Accountable Software directly. For more information or to obtain your
registration keys, please call (484) 875-0600 or email mailto:ASIsales@accountable.com.
To register the AnyView Browser or AnyView Creator software:

1. Respond to the prompt.
2. Enter your Registration key.
3. Close the Registration window.

1. Respond to the prompt.


Start Microsoft Dynamics™ GP.

When starting Microsoft Dynamics™ GP, respond to the prompt that informs you that you are running
an unregistered version.


Click REGISTER.



The Accountable Software Registration window will display.

2. Enter your Registration keys.


Select the record for the AnyView Browser module by clicking in the Key 1 field.



Enter the AnyView Browser key 1 exactly as you received it from us.



Tab to the Key 2 field and enter AnyView Browser Key 2 exactly as you received it from us.



If you are also registering AnyView Creator, repeat these steps entering the registration keys
you received for AnyView Creator.



Click REGISTER.



Verify the User count and Expiration date.
If you mistyped the keys, you will receive a warning message. Try to enter
the keys again, and if you still receive a warning, contact Accountable
Software. for assistance.

3. Close the Registration window.
If the module(s) you are registering now appears with a checkbox in its Registered column, close the
Accountable Software Registration window.
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You can reach the registration window any time by choosing Help > About Microsoft Dynamics™ GP and
then clicking Extras > AnyView from the Application Menu while the Microsoft Dynamics™ GP About
window is open.
Click the HELP button on the Accountable Software Registration window to send an email to Accountable
Software requesting assistance with registration.

AnyView Browser must be registered separately from
AnyView Creator using separate registration keys.

Technical Support
Accountable Software Customer Support is available Monday through Friday from 9:00 am to 5:00 pm
Eastern time.
Customer Support can be reached in the following ways:
484.875.0600 (voice)
484.875.0620 (fax)
TechSupport@accountable.com
http://www.accountable.com
When you call, fax, or email Accountable Software for support, please include the following information:


Your company name and phone number.



Your name.



The name of the product you are working with and the version you are running (from the
registration window).



A brief description of the problem.



In addition, have this manual available when you are connected with Customer Support—you
may be directed to various pages in the manual as you receive assistance.



Please also be aware that all technical support issues are chargeable unless the issue you are
calling about is a result of a defect in an Accountable Software product or accompanying
documentation. Customers without pre-paid support incidents, will be required to provide credit
card information prior to opening an incident, but will not be charged if the call is nonbillable. For
the latest Accountable Software Support Policies, see the “Support” section of the Accountable
Software Web site. www.accountable.com
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AnyView Browser Setup
Once installed, AnyView Browser must be set up in Microsoft Dynamics™ GP and in Internet Information
Server or Internet Service Manager before attempting to access the web site. This is a four-step process:
1. Synchronizing AnyView Tables: Describes the process of synchronizing database tables for
AnyView Browser.
2. ODBC Setup: Describes creation of data source names for your System and Company
Databases.
3. Enter Data Source Names (DSNs): Explains how to configure AnyView in Microsoft Dynamics™
GP.
4. Web Application Creation: Explains how to create the AnyView Web Application in Internet
Information Server or Internet Service Manager.
5. Security: Explains how security for AnyView is assigned.
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AnyView Browser Window Navigation
The following items are added to your Microsoft Dynamics™ GP menus during AnyView Initialization:
Several of these menu items apply to AnyView Browser only.

The following Menu Items are used for the AnyView Browser Report Publishing Feature.
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AnyView Browser Windows
Utilities ->System
Menu item

Window

AV Creator Wizard

ASI_AnyView_Creator_Wizard

AV Goto Setup

ASI_AnyView_Goto_Maintenance

AV Drill Arounds

Drill_Around_Wizard

AV DSN Setup

ASI_AnyView_DSN_Setup

AV External Tables

ASI_AnyView_ExternalTables_Setup

AV Login Alias Setup

ASI_AnyView_Login_Alias_Setup

AV Web Page Setup

ASI_AnyView_WebPage_Setup

AV Login Page Creator

ASI_AnyView_LoginPage_Generator

AV Utilities

ASI_AnyView_WEB_Utilities

AV Web Object Setup

ASI_AnyView_Web_Object_Setup

AV Web Goto Setup

ASI_Browser_Web_Goto_Maintenance

AV Object Auditor

ASI_AnyView_Object Auditor

Utilities -> Company
Menu item

Window

AV Reports

ASI_AnyView_Report_Publishing_Maintenance

AV Report Groups

ASI_AnyView_Report_Group_Maintenance

AV Report Access

ASI_AnyView_ReportSecurityByReport

AV Report User Access ASI_AnyView_ReportSecurityByUser
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ODBC Setup
The second step in the setup process is to create the Data Source Names (DSNs) that AnyView uses to
connect to each company database in Microsoft Dynamics™ GP.

Microsoft SQL Server
AnyView requires only a single ODBC DSN in order to connect to your SQL Server Database(s). This
DSN can be the same DSN created for your local Microsoft Dynamics™ GP installation, or can be created
specifically for AnyView Browser.
Important Note: The Version 3.7X.XX.XX or higher SQL Server ODBC Driver (Sqlsrv32.dll) must
be loaded. This Version can be checked from the Drivers tab in the ODBC Administrator.
Create a Data Source Name
1.

Launch the ODBC Administrator.
a. From the taskbar choose Start > Settings > Control Panel.
b.
Choose Administrative Tools > Data Sources (ODBC)
c. Choose the System DSN tab.
d. Click the ADD button.
e. From the Create New Data Source window choose the SQL Server driver.
Be sure you have read the information in the Database Requirements section to
insure the correct version of your database driver.
f.

Click FINISH.

2. Enter a Data source name, Description, and create the Database.
a. Name the DSN so that it is descriptive of the Server it connects to. Write down this DSN
name, as you will need it later in the setup.
DO NOT put any spaces or non-alphanumeric characters in the DSN name.
b.
c.
d.
e.
f.
g.
h.
i.
j.
k.
l.

Enter a description of the Server DSN.
Choose the Server from the Dropdown list
Click NEXT.
Select W ITH SQL SERVER AUTHENTICATION USING A LOGIN ID AND PASSWORD PROVIDED BY THE
USER.
Enter the login ID and password of the database owner.
Click NEXT.
Check the checkbox for CHANGE DEFAULT DATABASE TO: and select the database name. Select
“Dynamics” to create the system DSN.
Uncheck the boxes for USE ANSI QUOTED IDENTIFIERS and USE ANSI NULLS, PADDINGS AND
WARNINGS.
Click FINISH.
Click TEST DATASOURCE. You should get the message: “TESTS COMPLETED SUCCESSFULLY!”
Click OK.
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Record Data Source Names (DSNs) in AnyView DSN Setup
The third step in the AnyView Browser setup is to enter the DSNs created earlier into the AnyView DSN
Setup window. This process tells Internet Information Server or Internet Service Manager which DSNs to
use to connect to your system database and each company database you have.
Important Setup Note: If you are changing your setup for a previously installed and running
AnyView Web Application, you must Unload the AnyView Web Application after making any
changes to the Paths or DSNs. Failure to do so can cause unpredictable results on your web
server. To Unload a web application, Press the “Unload” button from the “Virtual Directory”
tab on the Property sheet for the Virtual Directory in IIS manager. For IIS 6.0 on Windows 2003
Server, Unloading the web application is accomplished by stopping and starting the
Application Pool that contains the AnyView Web Application.
In Microsoft Dynamics™ GP, start DSN Setup from the Utilities > System palette. This opens the DSN
Maintenance window. (Figure 8, Next Page)
1. Enter the physical path of the directory containing your AnyView web site files. This is the path you
entered during the installation process. (Default was c:\Accountable\AnyView). If you are performing
this step from a workstation other than the workstation that has the AnyView Web site files, be sure
you have write access permissions for the destination Folder (UNC Share).

2. Enter the path to an existing temporary folder. AnyView needs a folder in which to store temporary
information in order to process the export to Word and Excel.
3. Use the dropdown list to enter the System DSN. For SQL Server databases you may use any DSN
that points to your SQL Server.
4. Enter the Session Time out setting. This setting determines the amount of inactivity time in minutes
that a user has before being automatically logged out of AnyView. The IIS Session timeout from the
IIS Manager Virtual Directory Configuration ->Options tab also causes a user to be forced to re-log in
to AnyView due to loss of session information. Typically these 2 settings would be set to similar
timeout periods.
5. If using Role Based Logins (i.e. External Users with AnyView Browser), enter the SQL username and
password in the "SQL Login for External Users" section. Note that this SQL user is only required to
have read access to the AnyView and the Application Data tables made visible to external nonMicrosoft Dynamics™ GP users. The username and password are encrypted in the AnyView.ini file.
(see 8. below)
6. Use the scrolling window dropdown lists to select the DSNs created earlier for each of your Company
databases. For SQL server DSN’s, You may use the same DSN that you used for the System DSN in
3. above, for all companies if desired.
7. Once you have completed the setup, click Save to save your settings to the AnyView.ini file. Be Sure
you have write access permissions for the destination Folder. Changes made to the anyview.ini file
will not take effect until the Web Application is unloaded as described above in the “Important Setup
Note:”
8. In order to increase security of your AnyView Web Application, you are strongly encouraged to mark
the AnyView.ini file in the web application as "not readable" by web users. On Windows 2000, In the
IIS Internet Services Manager console, select the anyview.ini file, right click, choose properties, and
insure the "Read" checkbox is un-checked. This task can be performed similarly with the
appropriate IIS control panel on Windows XP, or Windows 2003.
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Figure 8. AnyView DSN Setup Window.

Web Application Creation
The installation of the AnyView Server Components on the IIS server creates the Web Application used by
AnyView. Should you need to manually create a new Web Application, use the following steps.
Create the web application for AnyView in Internet Service Manager (Windows XP/2000/2003). Use the
following steps to create your web site directory.
Important Note; The screens for Windows 2000/2003 Server will appear slightly different than
those pictured here; however, the information entered on each screen is the same.
1. Open the IIS or ISM console.
2. Right click the Web Site on which AnyView will be published.
3. Choose NEW > VIRTUAL DIRECTORY. This will activate the New Virtual Directory Wizard.
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Figure 9. IIS Server Administration.
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4. The Virtual Directory Creation Wizard will open. Click NEXT to continue.

5. On the Virtual Directory Alias window, enter the Alias for your AnyView Application.

Figure 11. Naming the Virtual Web Directory.

6. Click NEXT >.
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7. Enter the physical path to the directory that you chose during the AnyView setup.

Figure 12. Specifying a Web Site Content Directory.

8. Click NEXT >.
9. Select the appropriate Security Settings. Consult the IIS/ISM documentation regarding these
security options.

Figure 13. Access Permissions.

10. Click NEXT >.
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11. Click Finish to finish creating the virtual directory.

You have now created the Virtual Directory for the AnyView Web application. After restarting the IIS
Admin Service, you will be able to log in to your AnyView web application.
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Security
The final step in the AnyView Browser setup process is assigning security in AnyView to the users of your
Microsoft Dynamics™ GP Application. AnyView Browser security uses three layers.

Web Application Security
Security from Internet Information Server or Internet Service Manager is assigned from within the
Microsoft Management Console at the Web Application Level.

Microsoft Dynamics™ GP Security
Login Security is assigned from within Microsoft Dynamics™ GP just as it would for any Microsoft
Dynamics™ GP window. The user logins created within Microsoft Dynamics™ GP are also used as
logins for the AnyView Browser.
The sole exception to this rule is Role Based Logins, which is detailed in this document in the section by
the same name.

View Level Security
Security to the views in AnyView is based on the security setup for Microsoft Dynamics™ GP SmartList.
All views that the user has access to in Microsoft Dynamics™ GP SmartList will also be available from
AnyView Browser. For more information on the SmartList security model, review the Microsoft
Dynamics™ GP System Setup Guide, Chapter 14, on Security.
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Using AnyView Browser
Once the installation and setup steps are completed, AnyView Browser is accessible from the Web Site
you have created. AnyView Browser has seven pages / components.
1.
2.
3.
4.
5.
6.
7.
8.

Login Page
Main Page
Quick Search Page
Results Page
Results Page Toolbar
Search Page
Columns Page
Logout Page

Listed below is an explanation of the functionality of each page.

Login Page
When accessing your AnyView Web page, you are first presented with the login page. Select your Login
Type, and enter a valid User Name and Password, then click LOGIN. If you select the wrong Login type, or
enter an invalid user name or password, the page will be reset and you will need to re-enter the
information.

Figure 15. The AnyView Login page.

In the unlikely event that: upon attempting to log in, you receive a login error describing error code 70 –
GPCONN.DLL and a permissions error, please refer to Appendix B. of this document.

A NYV IEW

Page 33 of 132

Accountable Software.

Main Page
The Main page in AnyView displays a Tree View displaying a folder for each company you have defined in
the AnyView DSN Setup within Microsoft Dynamics™ GP. Select the folder for the company you wish to
view.

Figure 16. The AnyView Main page.

After selecting the company folder, the tree view expands to display a list of the available views for the
current user. When you select a view, it will expand to display all of the favorites defined for that view.
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Quick Search Page
When you click an Object folder on the tree view, the folder will open and show all Favorites for that
Object. The Quick Search page will also appear.

Figure 17. The Quick Search page.

The Quick Search Page allows you to find the information you want without executing the entire Object
Favorite. Select the Column you want to search on, specify the search Operator (is equal to, begins with),
and specify a value, then click Process to run the search.
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Results Page
When a favorite is selected, the results section of the window fills with the records for that favorite and
displays the AnyView Browser toolbar (see Figure 16 below).
At the top of the record set are the headers for each column. Clicking on a header will sort the records
based on that column. Clicking the column once sorts the records in ascending order. Clicking the same
column header again displays the records in descending order. A visual cue next to the column name
shows the order in which the records are currently displayed (see Figure 16 below).

Figure 18. Results Page.

Summary Section
If Summary Information has been added for the selected object, these Sums and averages will be
displayed at the bottom of the last record in the Results Page, as seen in the example below.

Figure 18a. Results Page Summary Section.

For more information on adding Summary data to an object, see the Column Summary Options section of
the AnyView Creator documentation.
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Results Page Toolbar
At the heading of each results page is the AnyView Toolbar.

AnyView Toolbar

Figure 19. Results Page with Toolbar.

The AnyView Toolbar provides nine functions:
Hides / Shows the Treeview.
Opens the Search Page.
Opens the Columns Page.
Displays a list of Object Gotos
Display the Favorites Maintenance options.
Toggles the record display between single page and multipage MODE.
Navigates through each page of results.
Opens the Chart Wizard.
Opens the Print Dialog box and Prints the current record set to the printer.
Excel Export: Opens a download window, prompting the user to save the current record
set to an Excel file or open the record set in Excel.
Word Export: Opens a download window, prompting the user to save the current record
set to a Word file or open the record set in Word.
Logout: Ends the current session for this user. Clicking the logout button when finished
in AnyView frees a concurrent seat license. If a user does not logout after a period of
inactivity that lasts more than 20 minutes, the user is logged out automatically. This
setting in configurable in AnyView DSN Setup and in IIS/ISM.
Links to Accountable Software’s web site.
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Export to Excel
When you elect to export your AnyView results to Excel by clicking the Excel button on the AnyView
toolbar, the following window will appear.

Figure 20. Export to Excel.


Select TAB SEPARATED to send tab separated values to Excel



Select COMMA SEPARATED to send comma separated values to Excel



Select HTML FOR EXCEL 2000 to send HTML formatted text to Excel



Checking the UNFORMAT NUMBERS box will remove any formatting (such as dollar signs) from
numeric information in your AnyView results prior to sending it to Excel

Click OK to proceed.
The spreadsheet versions are downloaded in Text (Tab Delimited) or CSV format (Comma-Separated
Values). These files can be read into most spreadsheet packages and word processors. In order to
maximize portability, these files contain only the values (numeric or text) of the table cells; no formatting
such as information about column widths, cell merging, fonts or line breaks is included. Once you've
opened the file in Excel, immediately save it to disk before making any formatting changes. This will avoid
the need to reimport it should you run into problems formatting the table. Remember to save the file in the
native .XLS format rather than as a text file.
Note: Due to issues with Internet Explorer 5. 5 , please follow this recommended procedure for
downloading an Excel export file, or upgrade to Internet Explorer 6.0:


Choose OPEN FILE from the first Internet Explorer dialog box.



Choose Save As from the second Internet Explorer dialog box.



Once the file has been downloaded, you will be prompted with the choice to Open the file or close
the dialog box. Choose OPEN to view the file.



This is a documented defect in Internet Explorer 5.5. For more information regarding this issue,
please see the following link:
http://support.microsoft.com/support/kb/articles/Q281/1/19.ASP
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Export to Word
When you elect to export your AnyView results to Word by clicking the Word button on the AnyView
toolbar, the following window will appear.

Figure 21. Export to Word.


Select PLAIN TEXT to send simple text to Word



Select RICH TEXT to send information to Word in a rich text format



Select HTML FOR W ORD 2000 to send HTML formatted text to Word



Select HTML FIT PAGE FOR W ORD 2000 to send HTML that is formatted to fit on a Word page



Click OK to proceed.
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Search Page
The search page allows the user to enter search criteria for the current favorite being displayed.
Entering the search criteria consists of choosing the column to restrict by, choosing the search type and
choosing the search value.

Figure 22. The Search Page.

Enter the Column name by typing it in the Column field or using the Lookup window to select from a list of
all available columns (see Figure ).

Figure 23. The Columns selection page.

The Lookup list of columns can be sorted by Column Name, Sequence (the order that they appear in the
table), or Data Type by clicking the column header. Select a column by clicking on the Column Name.
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Choose the SEARCH TYPE from the drop down list. Enter the value to search for in the VALUE field. Click
the ADD CRITERIA BUTTON to add this criterion to the Selected Search Criteria list.
To remove added criteria, simply click on one in the Selected Search Criteria and hit the REMOVE CRITERIA
button. To clear all of the selected criteria click the REMOVE ALL button.
Selecting the MATCH CASE checkbox makes the entered search case sensitive.
Changing the MATCH radio button from ALL to ONE OR MORE allows records that match any of the search
criteria to be returned instead of only records that match all of the criteria.
Once you have entered the criteria you want, click the PROCESS button. While AnyView Browser is
returning the records, you will see the Processing page. Once all of the rows are returned, the results will
be displayed in the main page.
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Favorites Maintenance
FAVORITES MAINTENANCE allows users to save sets of search criterion as a Favorite in AnyView Browser.
The Favorites button displays a menu with one or more options for administering favorites saved in
AnyView Browser.

Figure 24. Favorite Maintenance Menu

When selecting the (Default) favorite or other favorite created in Microsoft Dynamics™ GP SmartList, and
then clicking the Favorites button, the user will have the Create AnyView Favorite option available.

Note: Important information regarding AnyView Favorites
1. AnyView Browser Favorites are not available in Microsoft Dynamics™ GP
SmartList.
2. Microsoft Dynamics™ GP SmartList Favorites are not editable in AnyView
Browser.
Create AnyView Favorite
The CREATE ANYVIEW FAVORITE window allows the user to Name a specific set of search criteria, and
save that search. This enables the search to be re-run whenever the user requests that favorite from the
Treeview.
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To save a set of search criterion, enter a name in the Favorite Name field. The Search Criteria field
displays the restriction that will be used for this favorite.
Click ‘Add Favorite’ once then name has been entered.

Figure 25. Create AnyView Favorite window.

Once an AnyView favorite has been created, the user will have the Modify AnyView Favorite and Delete
AnyView Favorite options available on the Favorites Menu.

Modify AnyView Favorite
The MODIFY ANYVIEW FAVORITE window allows the user to edit an existing AnyView favorite. Once a
favorite is created, it can be modified by selecting the favorite in the treeview, making any changes to the
search criteria, and then navigating to the Favorites > Modify AnyView Favorite menu option. Here the
name can be changed if desired, and the changes will be saved when selecting ‘Modify Favorite’.

Figure 26. Modify AnyView Favorite window.
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Delete AnyView Favorite
The DELETE ANYVIEW FAVORITE window allows the user to remove an existing AnyView favorite. After a
favorite is created, it can be deleted by selecting the favorite in the treeview, and then navigating to the
Favorites > Delete AnyView Favorite menu option. Here the favorite can be removed by selecting ‘Delete’.

Figure 27. Delete AnyView Favorite window.
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Columns Page

The Columns page allows you to define which columns will be displayed and the order in which they will
appear in the results page.

Figure 28. The Columns page.

The DISPLAY COLUMNS list contains all of the Columns displayed in the current view.
To add a column for display, enter the column name by typing it in the COLUMN field or use the
Lookup window to select from a list of all available columns.
The Lookup list of columns can be sorted by Column Name, Sequence (the order that they appear in the
table), or by Data Type by clicking the column header. To add the column to the list of displayed columns,
click the ADD COLUMN button. Remove any unneeded columns by highlighting the column in the displayed
columns list and clicking the REMOVE COLUMN button.
Use the Controls on the right to change the display order of the columns.
To change the order, highlight the column by clicking it in the display list and then clicking the appropriate
button on the right. You can move the column forward or backward one column at a time or move it to the
beginning or end of the list. When you have finished adding and sorting columns, click the process
button.
You will be returned to the results page with any newly added columns displayed in the order selected.
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Charting
AnyView Browser users can now utilize the power of AnyView and Microsoft Office XP to create and
publish charts securely within AnyView. What follows is a primer on how to accomplish this.

Charting Requirements


Microsoft SQL Server - AnyView Charting is available on installations that use a Microsoft SQL
Server database.



Microsoft Internet Explorer - Charting functionality is available when AnyView Browser is
viewed in a Microsoft Internet Explorer browser.



Microsoft Office XP Web Components - AnyView Charting requires that the Microsoft Office
XP Web Components be installed on each client machine that will be designing or displaying
charts. The Microsoft Office XP Web Components are freely available from the Microsoft web
site, and the Web Components install can also be found on the Microsoft Office XP CD. The
Web Components install can be deployed on your AnyView web server, so that AnyView users
can easily download and install the components on client machines.



Microsoft Office XP License - A Microsoft Office XP license is required on client machines that
are used to design charts. No license is required to display charts.



Internet Explorer Active X Security Settings - The Office XP Web Components are ActiveX
controls. They require that Internet Explorer browser security settings are configured to enable
the download of signed ActiveX controls, enable running ActiveX controls, and enable scripting
of ActiveX controls marked safe for scripting (Internet Explorer Tools Menu>>Internet Options
menu item>>Security tab>>Custom Level button for applicable web content zone>>ActiveX
controls section of Security Settings window).



Internet Explorer Domain Security Settings - The Office XP Web Components require that
Internet Explorer browser security settings are configured to enable access to data sources
across domains (Internet Explorer Tools Menu>>Internet Options menu item>>Security
tab>>Custom Level button for applicable web content zone>>Miscellaneous section of Security
Settings window>>Access data sources across domains security option). If the security setting is
not enabled, then you may receive the following dialog when loading the Web Components in
Internet Explorer:
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Chart Design
In AnyView Browser, select the favorite that contains the basic information that you wish to chart. Add
and/or remove columns and apply Search Criteria to the favorite as necessary. Once the data set for the
chart has been selected, then open the AnyView Chart Designer using the Charting toolbar menu button.
Charting button

Charting a data set in AnyView browser

Clicking on the Charting menu button, and selecting the New Chart menu item will open up the Chart
Designer window.
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Chart Designer
To design an AnyView Chart:


Enter a Chart Name (used for the favorite name in the treeview).



Select the Chart Visibility (visible to Everyone or Only Me).



Add Chart Fields to drop zones on the chart from the Chart Field List window.



Format elements of the chart (chart type, colors, titles, etc.).



Save the finished chart design.

Chart name

Chart visibility

Open Chart
Field List

AnyView Chart Designer window
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A chart design, ready to be saved:

Completed AnyView chart design

Save the Chart

Beware of spending too much time designing a chart, since your AnyView session may time out whilst in
the AnyView Chart Designer window. Periodically save the chart, and then modify it as required.
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Chart Display
To display a Chart, simply select it from the treeview.

Displaying a chart in AnyView

When a chart is selected from the treeview, the chart data will be retrieved from the database in real time.
Whilst the chart is being displayed, the data can be refreshed at any time, by right clicking on the chart
and selecting Refresh Data from the context menu.
The chart can be modified or deleted when it is being displayed, by selecting the Modify Chart or Delete
Chart menu items from the Chart menu on the toolbar.
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Charting Security
Using the Security window in the Web Object Setup wizard in Microsoft Dynamics™ GP, you can secure
Chart Favorites and secure Chart Maintenance.
Select the Object that you wish to set chart security for and proceed to the Web Object Security window of
the Wizard.


Allow users to create,modify, and delete personal charts and charts that are visible to everyone
by enabling the Chart Button Visible toolbar setting.



Restrict users to maintaining only personal charts by enabling the Save Personal Charts Only
toolbar setting.



Allow users to display a chart favorite by enabling the favorite.

Allow/disallow chart
favorite display

Allow/disallow chart
maintenance

Allow users to save
only personal charts

Web Object Setup Wizard Security window
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Microsoft Office XP Web Component Download Path
You can use the AnyView DSN Setup window to specify where AnyView Browser users can download the
Microsoft Office XP Web Components. These components must be installed on client machines in order
to use AnyView Browser Charting. When AnyView users try to display or maintain a chart and they do not
have the Web Components installed on their machine, they will be given the opportunity to download the
Office XP Web Component install from the path specified in the DSN Setup window. The install path
defaults to the Microsoft Office web site, though the install executable can be deployed on the AnyView
web server in order to simplify the download.

AnyView DSN Setup window

A NYV IEW

Page 52 of 132

Accountable Software.

Logout Page
When finished using AnyView Browser, it is recommended that you log out by clicking the Logout button in
the toolbar.
After logging out, you will be presented with the logout page, where you can begin a new session by
clicking the Login button.

Figure 25. The Logout page.
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Customizing the Look of Your AnyView Site
AnyView contains a number of facilities that allow you to customize the look and feel of your AnyView site.
The first (AnyView Web Page Setup) allows you to specify colors, fonts, text, and images that are used int
AnyView. The second allows you to set up information that appears on the AnyView “home page” that is
presented to a user when he or she successfully logs in. This functionality is detailed below.

AnyView Web Page Setup
AnyView Web Page Setup can be started from the Utilities > System menu. The AnyView Web Page
Setup facility allows system administrators to customize the appearance of the AnyView web site.
Administrators can affect the colors, fonts, text, and images that appear on their web sites, thus allowing
companies to tailor AnyView with their company branding.

Figure 26. AnyView Web Page Setup.

Key items on this screen include:
Screen Entry

Description

W EB FOLDER PATH

This entry identifies where the AnyView web is installed1

W EB PAGE

This entry defines the AnyView web page being modified. Valid selections are: Login, Logout,
Treeview, Results, Columns, Columns lookup dialog, and Search.

W EB PAGE SECTION

This selection identifies the section of the web page being modified.

BACKGROUND COLOR

Select a color for the background of the page section. If the selected color is not named, it will
appear as a hexadecimal entry, such as “&H400040”.

FONT NAME, COLOR, AND
SIZE

Use these entries to select the font properties for this web page section.

BITMAP PATH, W IDTH,
HEIGHT

Some AnyView web page sections contain images. With this set of entries, you can specify which
logos you want to appear on these web page section and set sizing characteristics for the images.

AUTOSIZE

Selecting this option forces AnyView to size the image as it appears in its original file.

TEXT

The Login and Logout pages contain textual instructions or introductions. Use this setting to
customize the text that appears on these pages.

AnyView Web Page Setup affects the appearance of the AnyView web site by modifying STYLES.CSS in
the AnyView web directory. A file called COPY OF STYLES.CSS is installed with AnyView for recovery
purposes.

1

Administrators who use this function must have access to the AnyView web virtual directory.
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AnyView Login Page Generator
AnyView gives you the power to easily and securely expose pertinent information to people outside of the
realm of normal accounting operations, people like Vendors, Customers, and Salespeople. AnyView also
gives you the power to generate entrance points into your AnyView web site for each of those groups of
user.
That power is provided by the ANYVIEW LOGIN PAGE GENERATOR.

Figure 27. AnyView Login Page Generator.

To generate a login page especially for a group of user:
1. Specify the W EB FOLDER PATH (where the AnyView web files are stored).
2. Specify a LOGIN TYPE. Choose from the following options:


All login types



Microsoft Dynamics™ GP users



Customers



Employee



Salespeople



Vendors

3. Pick a single company or all companies (this option allows you to create a separate login for each of
your companies, if you have multiple companies).
4. Name the login W EB PAGE.
5. Click PROCESS to generate the login page.
The above screen would generate a custom login entrance for Vendors called the “TWO Vendor Login”
page.

A NYV IEW

Page 55 of 132

Accountable Software.

AnyView Home Page Content
The AnyView Browser installation routine places a file called ANYVIEW HOMEPAGE.HTM into your AnyView
site directory. The contents of this page are displayed as an AnyView home page after a user logs into
AnyView.
Here is what the AnyView home page looks like when a user logs into AnyView after a fresh AnyView
install:

AnyView Home Page area

A customized ANYVIEW HOMEPAGE.HTM can deliver timely and topical information to your AnyView users.
ANYVIEW HOMEPAGE.HTM can be customized with any HTML editor (such as Microsoft FrontPage™ or
Microsoft Word™) to deliver the content you wish to deliver to your users, complete with hyperlinks and
other HTML elements and effects.
AnyView ships with a sample home
page called
ANYVIEW HOMEPAGE.SAMPLE.HTM.
At left is the AnyView home page as it
would appear if that sample was
renamed to ANYVIEW HOMEPAGE.HTM.

ANYVIEWHOMEPAGE.SAMPLE.HTM
exists for sample purposes only!

To customize the content of your
AnyView home page, use any HTML
editor to edit ANYVIEW HOMEPAGE.HTM.
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External Tables Support
In conjunction with AnyView Creator, you can now create Views based on tables that are not part of your
Microsoft Dynamics™ GP solution, and view them with AnyView Browser or in SmartList in some cases
(see Note). These tables can include any additional SQL tables, Access database tables, and other ODBC
compliant data sources.
NOTE: If the table can be accessed from the Same DSN as the Microsoft Dynamics™ GP Clients
use, then objects using the External table can be viewed in the Microsoft Dynamics™ GP
SmartList.
2

To expose external databases, tables, and SQL views to Creator, we need to:
•

Select a data source, Either the Microsoft Dynamics™ GP SQL Server Data Source radio button, or
any other ODBC DSN

•

Select a database,

•

Select tables and SQL views, and

•

Select columns.

The AnyView External Tables Setup wizard walks us through these steps:
1. On the AnyView Web Server, create a DSN that accesses the desired database.
This step is not needed if you choose the Microsoft Dynamics™ GP SQL Server Data
Source radio button on the second External Tables Setup Wizard dialog below.
2. In Microsoft Dynamics™ GP, select Utilities > System > AnyView External Tables Setup. If you have
not supplied registration keys for AnyView Browser, you will receive the following message: “AnyView
Browser must be registered in order to view AnyView objects that contain external tables in a Web
Browser, AnyView Creator must be registered in order to view AnyView Objects that contain External
Tables in SmartList”. Clicking OK will open the AnyView External Tables Setup window, and you may
proceed with external tables definition. However, any objects containing those external tables will not
function in AnyView Browser unless AnyView Browser is registered. Note also that objects containing
External Tables will not be visible in SmartList unless both of the following are true:
a. The Microsoft Dynamics™ GP SQL server radio button option is used to select the DSN for
the external table.
b. The AnyView Creator is registered from AnyView Registration Window.

3. Upon selecting Utilities > System > AnyView External Tables Setup. The screen on the following page
will appear.

2

Microsoft SQL Server databases only.
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Figure 28. AnyView External Tables Setup.

To remove an external table from Creator, select REMOVE EXTERNAL TABLES, select the external table
to remove, and click FINISH.
To modify external table definitions previously established, select MODIFY EXTERNAL TABLES, select the
table to modify, make your changes, and click FINISH.
To add an external table definition to Creator, select ADD EXTERNAL TABLES and click NEXT. The
SELECT DATA SOURCE screen (depicted below) will appear.
4. Complete the SELECT DATA SOURCE screen (depicted below).

Figure 29. Select Data Source.

Key fields on this screen include:
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Data Source – If the External Table you desire to access is accessible on the default Microsoft
Dynamics™ GP Data Source, you can leave the first option selected and skip to the User ID field,
Otherwise, you must select “Other ODBC source and specify the following 2 fields.



AnyView Server Name – specify the AnyView Web Server Name (typically a network computer
name). Leave this entry blank if the AnyView Web Server is installed locally. The AnyView
Server will fetch available DSNs.
Note: If you receive the error message: “Error Creating ASIProxy:
Business Object cannot be created”, when specifying a server name,
then the ASIProxy DSN service has not been properly configured on
the Web Server or you do not have permissions to access it. To
establish these permissions, refer to the “Installation for External
Tables" section of this document.
Data Source Name – select the DSN that accesses the desired external tables. Note that these
DSNs are fetched from the AnyView Web Server specified.



•

UserID and Password – specify the UserID and Password combination required to access the
external data source.

•

Database – specify the database name that contains the desired external tables. Note that this field is
required in order to access tables in a SQL Server database

5. Choose the Database for the object.
Note: If an External Table is defined as Company Database, then
SmartList will access the table or view in the database context of
the login company. AnyView Browser will access the table or view
in the database context of the favorites company folder.
•

Click NEXT >>.

The ADD EXTERNAL TABLES screen (depicted below) will appear.
6. AnyView will then list tables and SQL views in the external data source.

Figure 30. Add External Tables.
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Select the tables and SQL views you wish to expose to Creator and click NEXT >>.
7. External Tables Setup will then list the tables and views you previously selected and will fetch the fields
in those tables and views on the SELECT COLUMNS TO INCLUDE screen (depicted below).

Figure 31. Select Columns to Include.

Note: If AnyView cannot determine the data type of a field, the Data Type on this screen will be
displayed as “Unknown”. To use this field, you must use the AnyView Datatypes Utility to
change the data type of this column.
Select the fields you wish to expose to AnyView Creator and click FINISH >>.

The tables, views, and fields you selected will now be exposed to AnyView Creator. Refer to the window
below to see how these external tables will appear in your Creator table selection screens.
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Figure 32. AnyView Creator table selection with external table listed.

This concludes the process of exposing external tables to AnyView Creator. These external tables and
SQL views can now be treated like internal Microsoft Dynamics™ GP tables in Creator.

Note that AnyView objects that use these external tables and views will be available for use with AnyView
Browser. In some cases these objects can also be viewed in SmartList. See the SQL Server objects in
SmartList section for details.

Exporting and Importing External Table Objects
Related to the External table process is the import and export of objects based on these external tables
and views.

Export
AnyView objects that contain External Tables which are defined to use the Microsoft Dynamics™ GP data
source can now be exported.
If an exported External Table references a SQL View, then the SQL View definition will also be exported.
If the SQL View in the External Table definition is dependant upon other SQL Views, then the dependant
SQL Views will also be exported. The parent SQL View and all dependant SQL Views must exist in the
same database.

Import
When an AnyView object that contains SQL Views is imported, the import process will automatically
silently create the SQL Views in the appropriate databases. The import process decides where to create
the SQL Views based on the Database setting in the External Table Setup Wizard.
If a SQL View is defined as Company Database in the External Table Wizard, then the import process will
create the View in all company databases in a Microsoft Dynamics™ GP system, otherwise the import
process will create the view in the database specified in the External Table definition.
If an External Table is defined as Company Database, then SmartList will access the table/view in the
database context of the login company. AnyView Browser will access the table/view in the database
context of the favorites company folder.
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During import SQL views are always upgraded if they already exist in the database.
An external table definition is upgraded if the table master record is a duplicate (i.e., only columns differ)
otherwise a new table definition is created.
When importing an external table that references a physical table in the database, a check is made to
ensure that the physical table exists. If it does not , the import fails. (The Table must exist in all company
databases if the Data Source for that table was specified as ‘Microsoft Dynamics™ GP Company
Database)
You must be logged in as ‘sa’ or the Database owner (dbo) in order to import an external table
definition that contains a SQL View.

A NYV IEW

Page 62 of 132

Accountable Software.

SQL Server objects in SmartList
When using AnyView Creator, Created objects that contain External Tables or SQL Server Views can be
viewed in the Great Plains SmartList.
Objects using External Tables will be available in Microsoft Dynamics™ GP SmartList only if the tables or
views are on the same SQL server as the Microsoft Dynamics™ GP data and the “Microsoft Dynamics™
GP SQL Server” option was specified as the Data Source in the External Table Setup Wizard as shown
below.

Choose this option
to allow Objects
using this External
Table Definition to
be shown in Great
Plains Smartlist

Figure 33. Allow External Tables to be visible in Great Plains SmartList.

Data Source
The DATA SOURCE selection determines the DSN used to access an external object.
 Microsoft Dynamics™ GP SQL Server – Uses the Great Plains DSN to access SQL Objects
 Other ODBC Data Source – Uses the specified Server and DSN to access SQL Objects

Database
The DATABASE selection determines the database in which the External object exists.
 Microsoft Dynamics™ GP Company Database – Accesses the External Object in all Company
Databases.
 Fixed Database – Accesses the External Object only in the Database Named.
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Microsoft SQL Server Views
Creator and Browser now support SQL Server views. Views in your SQL Server database(s) can now be
used to create objects viewable from AnyView Browser (and SmartList in some cases). With this
functionality comes the ability to do Union Query views that can be used to create Multi-Company Objects.
Here are some examples of the views you can use to create powerful analyses of your information:
•

Use Union queries to create views of Multi Company information. For example, you could create a
SQL Server view that combines lists of orders from each of your companies, and use that SQL view to
display them in a single object in AnyView Browser.

•

Use aggregate functions to summarize, average, or perform other calculations on your data.

•

Use the SQL “OPENROWSET” statement to incorporate data from other non-SQL databases into the
Views. (see Microsoft Access example below)

A deep discussion of SQL Server views is beyond the scope of this document. It should suffice to say that
you can use views to manipulate data from multiple tables from multiple databases in ways that transform
that data into valuable information that can be accessed from AnyView Browser.

OPENROWSET SQL Query
Using an OPENROWSET SQL Query, a SQL View can be created based on tables existing in SQL
databases on other servers, and databases other than SQL Server, such as Oracle and Access
databases. Below is an example of a SQL View written to access the Orders table in the NWIND.MDB
Access database. This database exists on a different machine than our SQL Server, so in our example,
we accomplish both the task of accessing a separate machine, and accessing a non-SQL database.
View Text:
Create View Northwind_Orders
AS
SELECT NWOrders.*
FROM OPENROWSET('Microsoft.Jet.OLEDB.4.0',
'\\Server2\Databases\NWIND.MDB';;, Orders) AS NWOrders

An examination of this query shows:
“Northwind_Orders ” – This is the name that will be given to the view when this script is executed against
our database.
“NWOrders.*” – This is the local name we use to refer to the table we are accessing.
'Microsoft.Jet.OLEDB.4.0' – This is the OLE DB Provider for the database we are accessing.
“'\\Server2\Databases\NWIND.MDB'” – The path to the Access Database.
“Orders” – The name of the table for our view in the database we are accessing.
For more information regarding this functionality, search for OPENROWSET in SQL Books Online.
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Role Based Login Security
You can allow your Customers, Vendors, Employees, Salespeople, and other non-traditional users access
to your AnyView Website, and still maintain tight security. With the functionality of “Role Based” logins,
you can set predefined restrictions on the objects your business stakeholders can see. When creating an
object, a simple restriction procedure allows AnyView to restrict the records that the user can see based
on their login. So, for instance, when a customer logs into your AnyView Website, he will see only the
objects you have allowed him to see, and only those records that pertain to him.
There are six steps to implementing role based login security in AnyView. They are:
•

Maintaining Internet Information, a built-in Microsoft Dynamics™ GP facility that associates login
information with the Customer, Vendor, Salesperson, and Employee master records,

•

Maintaining User Setup, a built-in Microsoft Dynamics™ GP facility that maintains user login
information,

•

Establishing AnyView Login Alias Setup, which is used to tie Customer, Vendor, Salesperson, and
Employee login information to Microsoft Dynamics™ GP user logins,

•

Establishing SmartList Security for objects and Login Aliases,

•

Specifying Login restrictions when creating objects, and

•

Implementing column level security to restrict the columns that can be viewed and searched (detail
about column selection is available in the AnyView Creator documentation).

Each step is detailed below.

Internet Information
Each master record in the Microsoft Dynamics™ GP databases has a place to store Internet Information.
The Internet Information maintenance screen is reached by clicking the
Customer, Employee, and Salesperson
maintenance screens.

button on the Vendor,

The two fields LOGIN and PASSWORD
comprise the login information that
representatives of Vendor and
Customer partners will use to log into
AnyView. Employees and Salespeople
will use the login information found on
their master records.
The screen depicted at right illustrates
the AnyView login information for the
customer named “Aaron Fitz Electrical”.
The AnyView login information for
representatives of Aaron Fitz Electrical
is Login: AFitz and Password:
password. This login and password
applies to the specified Address ID (in
this case: “PRIMARY”), enabling you to
assign different logins to multiple
entities within the same organization.
These multiple entities can have
varying levels of access in AnyView.
Figure 34. Internet Information.
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User Setup
The standard User Setup screen is used to maintain generic Vendor, Customer, Salesperson, and
Employee Microsoft Dynamics™ GP logins.

Figure 35. User Setup.

The screen depicted above illustrates a generic Customer login record. This Customer login is associated
to individual Customers with the AnyView Login Alias Setup utility.

AnyView Login Alias Setup
The AnyView Login Alias Setup screen is used to associate Vendor, Customer, Employee, and
Salesperson Internet Information logins with their corresponding, and more generic, User Logins.

Figure 36. AnyView Login Alias Setup.

The screen depicted above associates the Customer user group with the Customer login alias. To set up
AnyView Logins, select a User Group and a Login Alias, then select one of the following options.


USE EXISTING INTERNET LOGINS AND PASSWORDS will create AnyView logins based on Logins and
Passwords that have already been entered in the Internet Information fields when doing the initial
setup (after AnyView has been installed, entering Login and Password information in the Internet
Information fields of master records will automatically create AnyView Logins). This process
must be run for previously established logins to be used by AnyView.



CREATE INTERNET LOGINS AND PASSWORDS FOR BLANK RECORDS* will create AnyView logins for
those master records in the selected User Group (Customer, Vendor, Salesperson, or Employee)
who have no completed Internet Information.
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CREATE INTERNET LOGINS AND PASSWORDS FOR ALL MEMBERS* will create AnyView logins for all
master records in the selected User Group (Customer, Vendor, Salesperson, or Employee).



Click PROCESS to generate the login information.

*When creating logins and passwords with AnyView, the Login ID created will be the Master ID. If
additional Addresses exist for a master record, the login will be created as Master ID plus an incremented
number for each additional Address record.
For Example: The First Internet Address Record for Customer Number SMITH would be assigned SMITH
as the login; the second Address record for SMITH would be assigned SMITH1, the third
SMITH2, and so on. The password is generated as a random eight-character string.
After creating AnyView Logins, you can manually change the login information for a user from the Internet
Information screen.
Important Note: When this process is run, a link is established between groups of users, such as
Customers or Vendors, and the DEFAULT LOGIN ALIAS specified on this screen. From this point forward,
any new entries for that user group will default to that Login Alias. You can change the Login Alias using
the Login Alias Maintenance screen.

External Login Maintenance for SQL Server Installations
Note: This section applies only to SQL Server and SQL MSDE Installations.
If your installation uses any version of SQL Server, External Logins are required to be unique. This
represents a change from the way AnyView previously handled External Logins. In versions of AnyView
Build 56 and lower, the combination of Login and Password created a unique login. This method has been
changed in order to provide additional functionality.
When saving Login and Password from the Internet Information window, AnyView will validate the Login
entered. If the Login is not unique, you will be presented with a warning telling you on which record this
Login is being used.

Figure 37. Duplicate Login Warning

You will then have the option of entering a different Login, or saving with the duplicated login. Figure 38
shows the message presented.
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Figure 38. Correct Duplicate Login Option

If you choose ‘Yes’, you will be directed back to the Internet Information window, where you can enter a
new Login. If you choose ‘No’, that Login and Password will be automatically expired. Upon logging in to
AnyView Browser with an expired Login, the user will be redirected to the AnyView User Settings window.

AnyView User Settings
The ANYVIEW USER SETTINGS window in AnyView Browser is opened when a Login entered at the main
Login window is expired.

Figure 39. AnyView User Settings window
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From the AnyView User Settings window, the user must enter a new Login and Password. If the user
enters an invalid or duplicated Login, or an invalid Password, upon submittal of the form, they will be
directed back to the Change Login window and asked to enter valid information. After entering a valid
Login, Password, and confirming the entered Password, the user clicks ‘Update User Settings’ to save the
new information. When the information is validated, the user is presented with the message displayed in
Figure 40 below.

Figure 40. Login and Password Change Confirmed

Once the changes are confirmed, the user can click ‘Continue Login’ in order to enter your AnyView site.
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Login Alias Maintenance
While editing logins and passwords for AnyView users on the Internet Information screen, you can
manually assign a Customer, Vendor, Salesperson, or Employee to Alias Users.
Typically, a Customer login will inherit security and access rights from the “Customers” Microsoft
Dynamics™ GP login Alias User. There may be circumstances when you may want to have a number of
different Alias User Customer logins with varying levels of access. The Login Alias Maintenance screen
allows you to manually assign AnyView Logins to Alias Users.
While editing logins and passwords for AnyView users on the Internet Information screen, select Extras
from the Microsoft Dynamics™ GP menu, then select Login Alias Maintenance.

Figure 41. Login Alias Maintenance.

Type an Alias User ID or select one from the Lookup list and click SAVE to change a user’s alias.
There are two steps remaining to implement Role Based Login Security in AnyView. The first is to
establish SmartList (and AnyView) Object Security for user aliases. This is accomplished with the
SmartList Security screen.
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SmartList Security
SmartList Security is used to grant access to SmartList (and AnyView) objects to Users. We use it here to
grant access to AnyView objects to Login Aliases, which by extension then grants access to members of
those Aliases.

Figure 42. SmartList Security

The screen depicted above illustrates that we have granted access to the Customer Items and Customers
objects to the user called Customer. Customer in this case is a Login Alias that maps to individual
AnyView Logins.
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Object Login Restrictions
At this point we have:


established a login and password for our users,



set up a user alias for each appropriate group of users (Customer, Vendor, Salesperson,
Employee),



set up Login Aliases that map to each group, and



established SmartList Security for the user aliases.

Users for whom we established all of that information can begin to log into our AnyView web site and
serve themselves information. One shortcoming of what we have accomplished thus far is that all users
in a certain group will see the same information. This may suffice for types of Objects whose information
is, generally speaking, public (for example: Item Lists).
This, however, may not suffice for types of information that is closely related to a single entity and should
be secured accordingly.
Examples include:


a Customer’s orders, invoices, payments, and balances,



a Salesperson’s contacts and customers,



a Vendor’s invoices,



and an Employee’s benefits.

In these cases, we need to be able to restrict the records of information that a user sees when he or she
executes an object in AnyView. To accomplish this, we use the Object Restrictions window (depicted on
the following page) when creating or modifying an object using AnyView Creator.
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Restrict by
Login

Figure 43. AnyView Creator - Object Restriction

The Object Restriction Window is the fourth window in the AnyView Creator Wizard (refer to the AnyView
Creator documentation for a full discussion of the Creator Wizard).
To restrict the records returned to a specific AnyView user based upon a relationship between his or her
login and information on those records:
1.
2.
3.
4.
5.

Select the TABLE in the Object which contains the restricting field,
Select the FIELD,
Check the RESTRICT BY LOGIN check box,
Choose the RESTRICTION TYPE, and
Click ADD RESTRICTION.

In the illustration above, we restrict the Sales Transactions that a user will see by mandating that the data
be filtered so that the Customer Number on that sales transaction is equal to the user’s login information.
Specifically speaking, AnyView knows who is logged in, fetches his or her Internet Information record, gets
the key value of the Master (Customer Master, Vendor Master, et cetera) record, and uses that value to
restrict the results returned by the object.
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Summary of Role Based Login Security
In summary, we can secure not just the objects that a user can see in AnyView, but also the data fetched
and presented by those objects. Along the way, we:
•
•
•

Established a login and password, for each Customer, Vendor, Salesperson, and Employee to
whom we wish to grant access to AnyView,
used User Setup to create logins for user group,
used AnyView Login Alias Setup to tie individual AnyView logins to generic Microsoft Dynamics™
GP Alias User logins,

•

used SmartList Security to grant user groups access to objects, and

•

used Login restrictions in AnyView Creator when creating objects.

The results of these setup operations are as follows:
•

We need only one Microsoft Dynamics™ GP login (Alias User) for each user group, so our User
Maintenance burden is light,

•

Individual user login information is maintained on master records, which is logical and easy to
understand,

•

Individual user login information is related behind the scenes to true Microsoft Dynamics™ GP
login information, so AnyView users outside of our organization never see actual Microsoft
Dynamics™ GP login information,

•

We can restrict the objects that groups of users can see, as opposed to establishing object
security for each and every user, and

•

We can restrict the data users see in an object’s results by their login. We only do this once for
each object that requires it. From there, AnyView handles the restriction of data for each user, so they
see only the data that is appropriate for their use.
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Browser Drill Arounds
You can establish ways to “drill” from Object lists to other lists or detail views of information. These “Drill
Arounds” then appear in the AnyView toolbar.
To create links between Objects and Drill Arounds or Detail Views, use the AnyView Web Object Setup
facility.

AnyView Web Object Setup
The Web Object Setup facility allows you to set up specific characteristics of SmartList and AnyView
objects for use within AnyView Browser.

Figure 44. Web Object Setup.

Select MODIFY OBJECT SETTINGS to change settings for an Object. The sole other option from this window
CLEAR OBJECT SETTINGS.
If you select MODIFY OBJECT SETTINGS, you’ll be taken to the SELECT W EB OBJECT window (depicted on the
next page).
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Figure 45. Select a Web Object.

Select an Object and click NEXT to proceed.

Figure 46. Select Web Object Restrictions.

Use this window to set Restrictions on web objects. These restrictions are applied to the Object being
modified when it is viewed in AnyView Browser. These restrictions cannot be modified by the user. Later,
In the Web Object Security Window, 1 or more of these Restrictions can be applied to the Object on a
Per-user or Per-User type basis.
In the above example, we have restricted Vendors to show only those that are on Hold.
Click NEXT to proceed to the SELECT W EB OBJECT GOTOS window.
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Figure 47. Select Web Object Gotos.

The SELECT W EB OBJECT GOTOS window enables you to establish Gotos for Objects viewed in AnyView.
These Gotos include: Drill Around Objects, which list information filtered to include only pertinent records,
and Detail Forms, which display single records or documents in detail.
Above we have established two Web Gotos for our Vendors Object: Vendor Form, which will be labeled
“Vendor Detail” in AnyView, and Vendor Item List (a Drill Around).
For both of these Gotos, we will pass the Vendor ID value from the Vendors Object to the drill around or
form, so they can display only the information we want to see.

After you are done setting up Gotos, click NEXT to proceed to the W EB OBJECT SECURITY window.
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Figure 48. The Web Object Security window

The Web Object Security window allows you to specify AnyView security settings for this Object as used
by Users and External Logins.
Select LOGIN TYPE to establish settings for types of users (Customers, Vendors, Salespeople). Select
USER to establish settings for specific users.
There are up to four settings categories:
FAVORITES: use this list to grant or deny access to certain Favorites in an Object to the selected User or
Login Type. In the example depicted above, we have specified that the user LESSONUSER1 can see the
Electronic Vendors Favorite of the Vendors Object, but not the Default Favorite.
RESTRICTIONS: use this list to specify which restrictions (of the restrictions added on the previous Web
Object Restrictions window) should be applied automatically when the object is viewed by a particular
User or Login Type. This can be useful when using a single object that should be restricted differently for
different audiences. (this will only be present if restrictions were added earlier in the wizard)
GOTOS: use this list to specify which web gotos can be used by a User or Login Type. In the example
depicted above, we have specified that the user LESSONUSER1 can use the Vendor Detail and Vendor
Item List gotos.
TOOLBAR: use these settings to specify what AnyView toolbar buttons a User or Login Type will see and
how the Search button, if displayed, will behave. The settings are as follows:
COLUMN BUTTON VISIBLE: uncheck this to remove the COLUMNS buttons from the AnyView toolbar
SEARCH BUTTON VISIBLE: uncheck this to remove the SEARCH buttons from the AnyView toolbar
SEARCH COLUMNS OF FAVORITE ONLY: check this button to limit the columns a user can search on.
Marking this option allows the user to search only the display columns of the selected favorite. For
example, you might want to disallow Customers from searching Inventory Items by Cost. By marking
the Search columns of Favorite Only option, and no including the Cost field as a column in the
selected favorite, this column becomes invisible to the user.
Click NEXT, then FINISH, to save your changes.
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How Web Gotos Work
By using the W EB OBJECT SETUP facility, you can set up Drill Arounds for Objects in AnyView. These Drill
Arounds allow a user to navigate through AnyView to find the information he or she needs.
Users can drill to Drill Around Objects, which list information filtered to include only pertinent records, and
Detail Forms, which display single records or documents in detail.
When Drill Arounds exist for an Object in AnyView, the toolbar will display a Goto button. Clicking the
button will display a list of Gotos for the Object being viewed.
Goto Button

Gotos List

Figure 49. Results with Gotos

To use a Web Goto, select a row to drill into by clicking on it (it will become highlighted as depicted
above), then click on the Goto name in the drop down Gotos List.
AnyView will then transfer the user to the Goto destination, displaying the detail for the highlighted row.
On the next page we show the Vendor Detail form and the Vendor Item List for the Vendor selected
above.
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Figure 50. The Vendor Detail form

Figure 51. Vendor Item List Drill Around results
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Extras
AnyView can serve files (content other than AnyView results) from your AnyView web site. This feature
can be used to put price lists, spec sheets, documentation, help files, and other information pertinent to
your audience in AnyView.
To accomplish this, complete the following steps.
1. Create an EXTRAS folder beneath your AnyView web site folder.
2. Create a folder (or folders) in Extras, named as you would like to see them appear in the AnyView
treeview.
3. Place the files you want to expose to AnyView in those folders.
For example, if you create an Extras folder with two folders called “Spec Sheets” and “Price Lists” beneath
it, you will see “Spec Sheets” and “Price Lists” folders in your AnyView tree view. Clicking those folders
will display the files contained therein.

Figure 52. Extras Folder Example
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AnyView Web Goto Wizard
The Web Goto Wizard facility allows you to create Web Gotos. A web goto is an action to be taken upon
selection of a goto menu option. Examples of web gotos would include the navigation to a URL, an ASP or
HTML page, the execution of a Crystal report, or the displaying of a particular file. The Web Goto Wizard
walks through the steps required to create these types of Gotos.

Figure 53. Web Goto Wizard.

Actions on this screen include:
•
•
•

Create a new Web Goto
Modify an existing Web Goto
Delete an existing Web Goto

These actions are detailed in the following pages.
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Create a New Web Goto
Select File
The SELECT FILE window allows you to choose which type of Goto you would like to create.

Figure 54. The Select File Window.

Select File Window Options
What Type of Web Goto do you want to create?
Select the type of Web Goto to be created. The options are listed below:
•
Crystal Report (ASP)
•
Crystal Report (Web Server)
•
URL
•
Streamed File
•
Detail View
Each of these types is detailed on the following pages
Crystal Report (ASP) Goto Type
The Crystal Report (ASP) Goto type creates a web goto that displays a Crystal Report in AnyView Browser
using ASP Pages distributed with the AnyView Browser installation. For further details regarding Crystal
Reports Gotos, consult the Crystal Reports Setup section of this document.
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Crystal Report (Web Server) Goto Type
The Crystal Report (Web Server) Goto type creates a web goto that displays a Crystal Report in AnyView
Browser using the Crystal Decisions Web Server Components. In order to display Crystal Reports with the
Crystal Web Server, reports must be saved to a specific folder. Please see the section on Important
Crystal Web Server Information for details on creating this folder. These components must be installed
separately from AnyView. For further details regarding Crystal Reports Gotos, consult the Crystal Reports
Setup section of this document.
URL Goto Type
The URL Goto type creates a web goto that navigates the user to a specified web page in the browser.
Streamed File Goto Type
The Streamed File Goto type creates a web goto that displays or downloads a file in the browser. Various
file types can be used a gotos, however, file types that are not recognized by the browser will prompt the
user to download the file, rather than displaying it.
Detail View Goto Type
The Detail View Goto type creates a web goto that displays a form style HTML representation of the
selected record.

How would you like this web goto to be displayed?
Inside the AnyView Results Frame
This option will display the selected Goto in the current AnyView window, using the same frame
used to display the object results. The object list will be replaced with the Goto contents until the
browser’s Back button is used. After selecting Back, the results list will once again be displayed.
In a new Browser window
This option opens a new window inside of the web browser, and displays the Goto contents in that
new window. The AnyView results list remains unchanged in the original window, where additional
records can be selected and Gotos executed.

Note: When creating a Crystal Report Web Goto, it is important to understand the
implication of the New Browser window display option. If this option is used for a
Crystal Reports Goto, the user can open more than one Crystal report at a time.
Since each opened report occupies a Crystal Reports license, it is conceivable
that a single user repeatedly opening Crystal Reports in new windows, without
ever closing those reports, could occupy all available Crystal licenses.
Will the web goto destination be based on the value of a field in the list?
No, always use the destination entered below.
Responding No allows you to enter a single destination file name or URL for the goto. The browse
button will allow you to navigate to the desired file.
Note: The selected file must be accessible from a valid UNC path on the IIS server.
Yes, base the destination on the field entered below.
Responding Yes allows you to enter a prompt and data type for the conditional field that will
determine the web goto destination. The prompt and data type entered are used when adding the
created goto to a web object using the Web Object Setup Wizard. For further detail on adding
gotos to objects, see the Web Object Setup section of this document.
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Note: When creating a Crystal Report Web Goto, and choosing the conditional option,
all reports must have the same number of parameters, and the parameters must
be listed on the reports in the same order.
Select File Example: If we wanted to create a goto for a list displaying a Customer’s open Sales Transactions, and used as the
destination, different Crystal Reports depending on the type of Sales Transaction, we could accomplish this with a web goto. The
first step would be determining the type of web goto to create. In this case, the type would be Crystal Report (ASP), because we
have not installed the Crystal Web Server. The second step is determining how many types of Sales Transactions we could
potentially be displaying. If the answer were more than one, then we would respond Yes, to create a Conditional Goto. The next
step would be to determine the field that contains information about which Sales Transaction type is being selected. In this case,
the SOP Type field contains that information, so we would enter ‘SOP Type’ in the conditional prompt field, and select the
‘Integer’ Data type from the dropdown list. Were we not sure of the data type, we would use the Microsoft Dynamics™ GP Field
or Table Descriptions window to retrieve that information.

Select the Goto Type and the UNC File Path or enter the Field Prompt and Data Type, then click Next>>.
If the Goto will be conditional upon the value of a field, then the Conditional Files window will open,
otherwise, the Parameters window will be opened.
When creating a Detail View, the select Drill Around window will open. The remainder of the Detail View
creation steps are covered in the Create Detail View section.

A NYV IEW

Page 85 of 132

Accountable Software.

Conditional Files
The CONDITIONAL FILES window allows you to enter possible values and the resulting destination used
when that value is matched.

Figure 55. The Conditional Files Window.

Is Equal To
Enter possible values for the If field in the Is equal to… column. For each value entered, select a file, or
enter a URL to be used as the destination.
Conditional Files Example: In Figure 53, we see that the conditional If field is SOP Type. The possible values for SOP Type are
1 through 5. For each value for which we would like to use a different destination, we enter that value in the Is equal to…
column, and then select the desired destination file. In this case, we want to use a different Crystal Report for Quotes (SOP Type
1) then we do for Orders (SOP Type 2) and Backorders (SOP Type 5). Invoices and Returns (SOP Type 3 and 4) are not listed in
the scrolling window. By adding an additional report to the Or, if no match is found, use… field, the SOP Types not listed will
display using this report. We use the value 1 rather than the text ‘Quote’, because we need the literal value of the field as it is
stored in the database table.
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Or, if no match is found, use…
The Or, if no match is found, use… field allows us to enter a destination for values not specifically listed
above. If all possible values are listed in the Is equal to… field, it is not necessary to enter a value for the
Or, if no match is found, use… field.
Example: Assume we wanted a conditional report based on a field such as the Customer’s Country. And wanted a separate
report if the customer is based in Canada. Rather than enter every possible country, including Canada, we would enter only
Canada in the Is equal to… field and select the desired destination report. Then, we would enter our default report, to be used
by all other countries in the Or, if no match is found, use… field.

Enter the values and desired destination files, then click Next>>.
If the Goto will use a Crystal Report, the wizard will connect to the report to retrieve parameter information.
In the case of a conditional goto, only the first report listed in the Conditional Files window is used as the
source for parameters.

Note: The process of opening and reading the report may take a few moments. Allow
this process to finish, and then proceed with the Enter Parameters step.
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Enter Parameters
Parameters are used to retrieve information from the selected record in the object list, and use those
values as restrictions for the destination. The Enter Parameters window behaves differently depending
upon the type of goto being created.
Crystal Report Parameters
If a Crystal Report goto is being created, the list of parameters is retrieved from the Crystal Report, and
displayed in the scrolling window. For Crystal Report parameters, the available parameters, the Parameter
Name and Data Type cannot be changed in this window. To alter these properties or to add additional
parameters, you must make these changes to the report itself.

Figure 56. The Enter Parameters Window for a Crystal Report.

File Name
Displays the name of the report entered as the destination for the Web Goto. This Property is Read Only.
Parameter Name
Displays the names of the parameters on the selected Crystal Report. This Property is Read Only.
Data Type
Displays the data type of the parameters on the selected Crystal Report. This Property is Read Only.
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Value Source
The Value Source determines where the parameter’s value will come form. The available choices for
Crystal Report parameter Value Sources are:
•

URL - The parameter’s value will be retrieved from a field in the selected row of the displayed
object results. This parameter must be mapped to a field in the object, when this goto is added
using the Web Goto Setup Wizard.

•

Constant – The parameter’s value will be entered on the Enter Parameters window, and that value
will always be used.

•

Restrict By Login - The parameter’s value will be determined by the Login ID of the current user.

•

Default - The Default Value entered on the Crystal Report parameter will determine the
parameter’s value. If this parameter has no default value saved on the report, you will be
prompted to select a different Value Source.

•

Prompt - The parameter’s value will be prompted for in the AnyView Browser Parameter form.
The Prompting Text of the Crystal Parameter will be displayed to the user when requesting the
goto, as seen in figure 54.

Value
The Value column is used to enter the parameter value when Constant Value Source is selected. The
value entered must match the data type of the parameter. Only single values can be entered, commaseparated values are not supported.
If the Prompt Value Source is selected, the Value column displays the prompting text that will be displayed
to the user when requesting this goto.

Figure 57. AnyView Browser Crystal Report Parameter Prompting Window
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Crystal Report Parameters Example: When selecting a Crystal Report Goto, the parameters saved on the report are listed on
the Enter Parameters window. In our example, we have chosen to display a SOP report. The object that we are creating the
Goto for does not contain fields for all of the report parameters. In this case, those values must be retrieved from some other
source. We are entering, as Constants, the values for Location Code and Component Sequence. The user will enter the Force
Functional parameter value when the report is requested. The other parameters will be retrieved from fields in the object.

URL Parameters
If a URL goto is being created, the list of parameters must be manually entered. The parameter name
must match the name expected by the URL.

Figure 58. The Enter Parameters Window for a URL.

File Name
Displays the name the first URL entered as the destination for the Web Goto. This Property is Read Only.
Parameter Name
Field to enter the names of the parameters sent to the selected URLs.

Note: For Conditional URL gotos, the parameters do not need to match. All Parameters
for all URLs can be listed together. Parameters that are not required by the
URL are typically ignored.
Data Type
Field to enter the data type of the parameters sent to the selected URL.
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Value Source
The Value Source determines where the parameter’s value will come from. The available choices for URL
parameter Value Sources are:
•

URL - The parameter’s value will be retrieved from a field in the selected row. This parameter
must be mapped to a field in the object, when this goto is added using the Web Goto Setup
Wizard.

•

Constant – The parameter’s value will be entered on the Enter Parameters window, and that value
will always be used.

•

Restrict By Login - The parameter’s value will be determined by the Login ID of the current user.

Value
The Value column is used to enter the parameter value when the Constant Value Source is selected. The
value entered must match the data type of the parameter. Only single values can be entered, commaseparated values are not supported.
URL Parameters Example: In our URL example, we are linking to several different Shipping Carriers’ package tracking web
sites depending upon the value in the ‘Shipping Method’ Field. The parameters for each carrier vary, so we enter all parameters
for all carriers in the list. When this goto is used, and the carrier’s ASP page is called, only the parameters required by the page
will be used.

After entering the information for each parameter, click Next>>.
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Add Selection Criteria
The ADD SELECTION CRITERIA window will open when creating a Crystal Report Web Goto. This window
allows you to add additional restrictions to the Crystal report. Unlike Parameters, which must exist on the
report, Selection Criteria can be used to dynamically restrict the records displayed when the report is
requested.

Figure 59. Add Selection Criteria

Values entered in the Add Selection Criteria window are appended to the existing report selection criteria,
and are used by the report to further restrict the records displayed.
File
The File field Displays the Name of the Crystal Report used for the goto.
Select Column
The Select Column field displays the Crystal Report Table and Field name. This name is displayed in the
syntax used by the Crystal Reports Select Expert.

Note: When using the Crystal Web Server, Selection Criteria will Replace not add to
existing Selection Criteria on the report. For more information about this
functionality, see the Crystal Decisions Web Reporting Administrator’s Guide.
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Column Lookup
The Column Lookup button opens the Select Selection Criteria Column window.
Select Selection Criteria Window
The Select Selection Criteria window displays the tables used to create the Crystal report. Expanding a
table displays a list of columns in the table as they are seen by Crystal Reports.

Figure 60. Select Selection Criteria window.

After location the column needed for the selection criteria, double click the column name or highlight the
column and click Select>>.
Datatype
The Datatype field displays the column datatype as it is read by Crystal Reports.
Selection Source
The Selection Source determines where the criteria’s value will come from. The available choices are:
•

URL - The criteria’s value will be retrieved from a field in the selected row of the displayed object
results. This criteria field must be mapped to a field in the object, when this goto is added using
the Web Goto Setup Wizard.

•

Constant – The criteria’s value will be entered on the Add Selection Criteria window’s Value field,
and that value will always be used.

•

Restrict By Login - The criteria’s value will be determined by the Login ID of the current user.

Value
The Value column is used to enter the criteria value when the Constant Selection Source is selected. The
value entered must match the data type of the parameter. Only single values can be entered, commaseparated values are not supported.
After adding Selection Criteria, click Next>>.
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Selection Criteria Example: In our Selection Criteria example, we are adding criteria to restrict a Sales Transaction Invoice
report. The report has existing selection criteria that reads: ‘{SOP10100.SOPTYPE} = 3’
This selection criterion ensures that only invoices are displayed by this report. However, to use this report for a Web Goto, we
need to also ensure that only the Sales Transaction selected in the object is displayed on our report. One way to accomplish this
would be to simply add additional selection criteria to the report, using a parameter. This method however, reduces the flexibility
of the report, by always restricting records to a specific SOP Type AND SOP Number. By instead, using Selection Criteria, we
can reuse this same report for several purposes. Adding the {SOP10100.SOPNUMBE} column, and using a Selection Source of
‘URL’ allows us to retrieve the value of the SOP Number field from our selected row were we to assign this goto to an object
displaying Sales Transactions. If we then needed to reuse this report for a goto to display all transactions for a given customer,
we could use the same report, and add Web Goto Selection Criteria for {SOP10100.CUSTNMBR} and choose ‘Restrict By Login’
as the Selection Source. We would now have two separate gotos, displaying records based on different criterion, but both based
on the same report.
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Finish
The FINISH window allows you to enter a name for the Web Goto.

Figure 61. Finish Window

After verifying your selections and entering a unique name for the Web Goto, click Finish.
The AnyView Web Goto Wizard will create the new goto. Once it is finished, the Web Goto can be added
to objects using the Web Object Setup Wizard.

Note: Goto Names must be unique in order to be saved.
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Create a Detail View
A Detail View Goto is an HTML page layout of a single record selected in the AnyView Browser Results
window. This view provides a display of a single record, more easily interpreted than that of the list of
possibly multiple records shown by the Results page. In addition, the Detail View can display information
associated with that record in a single page, rather than using a Drill Around to find that associated
information in another object.
The process of creating a Detail View is outlined below. It is displayed separately from the main Web Goto
process, as the listed steps are unique to creating detail views.

Select Main Drill Around
In the SELECT MAIN DRILL AROUND window, choose the Drill Around that will be the source for the Detail
View Header. This Drill Around is important because it provides the parameters that will be passed to all
subsequent Drill Arounds used for additional sections of the Detail View.

Figure 62. Main Drill Around Window

Note: All Drill Arounds used in a single Detail View MUST have the same number of
parameters. These parameters must also be of the same data type.

After selecting the main Drill Around, click Next>>.
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Additional Drill Arounds
The ADDITIONAL DRILL AROUNDS window is used to select secondary sources of data for additional sections
of the detail view.

Figure 63. Additional Drill Arounds Window

To add additional Drill Arounds, select a Drill Around from the displayed list, and click the ‘Add’ button.

Note: Each Drill Around added represents a section of the Detail View and must be
added in the order that it is to appear on the Detail View. Each section can be
based on a separate Drill Around, or the same Drill Around can be used for all
sections. Where possible, the reuse of the Same Drill Around will produce a
faster running Detail View.
Additional Drill Arounds Window Options
Header Drill Around
Displays the Drill Around Selected as the Main Drill Around for the Detail View.
Selected Drill Arounds
The scrolling window which displays the additional Drill Arounds added to the Detail View.
Sequence
Displays the order in which the Section will be displayed on the Detail Page.
Drill Around Name
Displays the name of the Drill Around selected for the Section.
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Page Section
This dropdown list is used to choose the name of the section created by the selected Drill Around.
A Detail View can contain up to 9 sections in total. Each section must use a unique Page Section
Name, and sections that may display multiple records must use either DETAIL, DETAIL1, or
DETAIL2 section names.

Note: The Page Section selected becomes important especially when creating a detail
view with a line item or detail section. In order to display multiple rows such as
Sales Line items or Customer Addresses, the section must be labeled using one
of the Detail Section types.
Additional Drill Arounds Example: As an example, we will create a Sales Transactions Detail View. As the Main Drill Around
for the page header, we will choose a Drill Around based on the Sales Line Items object. We use the Sales Line Items object
instead of a Drill Around based on the Sales Transactions object because all of the Columns we will need for the page header
exist in the Sales Line Items Drill Around. This will create a detail view which displays much faster.
For the Additional Sections, we again choose the Drill Around based on the Sales Line Items object, and set the Page Section to
DETAIL. The page footer, will also use the Drill Around based on the Sales Line Items object, and use FOOTER as the Page
Section.
These options will create a Detail View with three sections, a Header Section to display document information, and customer
information, a Detail Section to display the line items from the transaction, and a footer to display the Subtotal amount, Taxes,
and Document Amount etc.

After adding additional Drill Arounds, click Next>>.
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Select Columns
The SELECT COLUMNS window allows you to define the columns for each section of the Detail View. The
displayed list of columns are those made available by the Section Detail View. Select the required
columns, and click ‘Insert’. Notice that the column is not removed from the available list once it is added to
the selected list. This is to allow the addition of the same column more than once, as some layouts may
require. Once all of the required columns have been added for the selected section, use the section
dropdown list choose the next section. Notice that the selected columns window is now cleared. This
allows you to keep track of the columns added for the selected section.

Figure 64. Select Columns Window

Select Columns Window Options
Sections Dropdown list
Displays a list of the Sections chosen for the Detail View.
Insert
Adds the column selected in the available columns list to the selected list.
Insert All
Adds all of the selected section’s columns from the available list to the selected list.
Remove
Removes the highlighted column of the selected Section from the selected list.
Remove All
Removes all of the columns of the selected Section from the selected list.

A NYV IEW

Page 99 of 132

Accountable Software.

Note: Columns will appear on the Detail View in the order they are added to the
selected columns list. If a column of the source object is not displayed in the
available columns list, check that it has been included in the source Drill Around.
Continue adding the needed columns for each section, then click Next>>.
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Section Titles
The SECTION TITLES window allows the entry of the Goto Name, and an optional name and style for each
section of the Detail View.

Figure 65. Section Titles Window

Section Titles Window Options
Page Title
Allows entry of the Goto name as it will appear in the Web Goto Wizard, and in the Header of the created
Detail View.
Page Section list
The scrolling window which displays the sections of the Detail view.
Page Section
The name of the displayed section.
Drill Around Name
The source Drill Around for the section.
Section Title
An optional display name which displays as a label for the section in the completed HTML page.
Section Style
An optional style to use when creating the HTML for the section.
Section Style Lookup
The Section Style Lookup button opens the Page Section Thumbnails window.
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Note: It is recommended that you choose a style for each section of the Detail View,
however, advanced users may wish to modify the final HTML page using a web
page editor. In this case, leaving the Section Style blank will result in a section
with all of the included columns, but with no formatting or links to the Detail View
Style Sheet which may be easier to modify manually.

Page Section Thumbnails
The PAGE SECTION THUMBNAILS window displays an example of the different layout styles that can be
automatically applied using the Detail View wizard. Use the VCR buttons to scroll through the list of
examples.

Figure 66. Page Section Thumbnails Window

Available Styles
Double Column:

Suitable for header or footer ‘master record’ type information, in a ‘transactional’
style detail view. This style creates a table with 5 columns. One column of
prompts, a column of data, a blank column, then a second column of prompts
and data. The number of rows is determined by the included columns of the
section.

Single Column:

Suitable for header or footer information in a ‘master record’ or ‘transactional’
style detail view. This style creates a table with 3 columns. One column of
prompts, one column of data, and a blank column. The number of rows is
determined by the included columns of the section.

Alternative Color Detail: Used for any section which will display more than a single record. This style
creates a row of prompts, then repeats the rows of data for as many as are
returned by the view. The number of columns is determined by the included
columns of the section.
Right Justified Column: Best suited for footer information in a ‘transactional’ style detail view. This style
creates a table with 3 columns. One blank column, one column of prompts, and
one column of data. The number of rows is determined by the included columns
of the section.
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Note: When choosing a style for the Detail View sections, it is important to be aware of
the intended use for the section. You must always choose “Alternate Color Detail”
for a section which will display multiple records, as this is the only style which will
display multiple records correctly. For Headers, Sub Headers, Footers, and Sub
Footers, you can choose from any of the available styles.
After selecting the desired style for the section, click OK.
After naming the Detail View, and optionally entering titles and styles for each section, click Next>>.
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Finish
The FINISH window completes the creation of the Detail View. After selecting all of the options for the
Detail View, click Finish to create the Detail View. The Web Goto wizard will create the HTML and pages
needed to display the Detail View. The Select pathnames window opens as a prompt for the path in which
to create these pages. Whenever possible, this path should be the AnyView web application physical
directory. If this folder is not available from the current workstation, a local or shared network path can be
used. If selecting a folder other than the web application physical directory, the created pages must then
be moved manually to the appropriate folder on the IIS machine.

Figure 67. Finish Window

Finish Window Options
Page Name
Displays the name of the pages to be created. This name will be appended to the ‘.asp’ and ‘.htm’
extensions to create the required files.
Open the Web Object Wizard when Finished
After creating the Detail View, to make use of it, it must be attached to an existing object as a goto using
the Web Object wizard. Marking this checkbox will automatically open this wizard.

Note: If the Detail Page Title was entered with a space, the created page names will
replace the space with an underscore.

Additional Modifications
For those users familiar with HTML, the detail view can be further modified using a web page editing tool
such as Microsoft Front Page. See Appendix A of this document for further details.
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Modify An Existing Web Goto
Select Web Goto
The SELECT W EB GOTO window displays a list of previously created Web Gotos.

Figure 68. Select Web Goto window.

Choose the desired goto from the list, and click Next>>.
The steps for modifying a goto are similar to creating a new goto except that each window will display the
data previously saved.

Note: When modifying a Crystal Report Goto, the parameters saved on the report are
displayed. If new parameters have been entered on the report, they will be
listed in the Enter Parameters window.
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Delete an existing Web Goto
Select Web Goto
When deleting an existing Web Goto, then Select Web Goto window opens, allowing you to select the
goto to be deleted. After selecting the desired goto, click Next>>.

Finish
The FINISH window allows you to verify that the selected Web Goto is the correct goto to be deleted. Click
Finish to permanently remove the Web Goto.
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Crystal Reports Setup
In order to create a Web Goto based on a Crystal report, it is required that the Crystal Reports Web
Reporting components be properly installed and configured on the IIS Server, and that the proper Crystal
Reports components are installed on each machine associated with setting up and processing the Crystal
Report. These components differ depending on the version of Crystal Reports you have installed and the
machine’s role in the reporting process.

Web Reporting Setup for Crystal Reports 8.0
Internet Information Server Setup
The IIS Server is responsible for processing Crystal Report requests. In order to do so, the Crystal 8.0
Web Reporting components must be installed on the server. To properly install Crystal Reports 8.0, it is
recommended that you follow the procedure documented by Crystal Decisions in the following Technical
Paper:
3
Installing Crystal Reports 8 for Web Reporting
Web Reporting Components for Crystal Reports 8.0 can be installed using one of the following methods:
1. Install the full version of Crystal Reports 8.0 Professional, including the Web Server components.
2. Install the full version of Crystal Reports 8.0 Developer addition.
3. Copying and registering the correct files from an existing Crystal Reports 8.0 install to the IIS
Server.
Administrative Workstation Setup
The Administrative Workstation is a machine on which you will perform the setup of Crystal Report Web
Gotos in Microsoft Dynamics™ GP, for use in AnyView. The requirements for this machine are listed
below:
1. Microsoft Dynamics™ GP client installation.
2. Crystal Reports 8.0 installation (This can be the CR 8 Professional or Developer Addition).
3. AnyView Client installation.
Once these required software packages are installed, this machine can be used to create Crystal Report
Web Gotos. You may choose to use several different workstations for administration. If this is the case,
each administrative workstation must meet the requirements listed above.
Browser Client Setup
The Browser Client is a workstation from which users will connect to the AnyView Browser using a
supported Internet Browser such as the Internet Explorer or Netscape browser. In order to view Crystal
Report Gotos, the Browser Client must have the required components installed.
1. A supported Browser installation.
2. A Crystal Reports Web Viewer installation.
The Crystal Reports Web Viewer is a Browser component downloaded to, and installed on, the client
machine that enables the client to display the requested report. By following the documented Crystal
Decisions procedures, the IIS Server can be configured to automatically download the correct Report
Viewer for the client’s browser. AnyView Browser uses two Crystal Reports Web Viewers.
Crystal Reports Active X Viewer:
This viewer is used for Internet Explorer Browsers.
Crystal Reports Java Plugin Viewer: This viewer is used for Netscape Browsers.
For Troubleshooting information regarding the Web Viewers, see the following Crystal Decisions
Technical Paper:
http://support.crystaldecisions.com/communityCS/TechnicalPapers/crystal_web_viewer_for_actx.pdf.asp
3

Note: All links to Knowledgebase articles, White Papers and downloads were valid as of the completion of this
document. Because of changes in the location of some files, some links may no longer be valid. Please contact
Crystal Decisions for the new location of any invalid links.
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Web Reporting Setup for Crystal Reports 8.5
Internet Information Server Setup
The IIS Server is responsible for processing Crystal Report requests. In order to do so, the Crystal 8.5
Web Reporting components must be installed on the server.

Web Reporting Components for Crystal Reports 8.5 can be installed using one of the following methods:
1. Install the Crystal Enterprise 8.5.
2. Install the full version of Crystal Reports 8.5 Developer addition.
3. Copying and registering the correct files from an existing Crystal Reports 8.5 Developer Addition
install to the IIS Server.
To properly install Crystal Reports 8.5 Web Components without installing Crystal Enterprise, it is
recommended that you follow the procedure documented by Crystal Decisions in the following Technical
Paper:
4
Manual Installation for the ASP Web Report Server

Administrative Workstation Setup
The Administrative Workstation is a machine on which you will perform the setup of Crystal Report Web
Gotos in Microsoft Dynamics™ GP, for use in AnyView. The requirements for this machine are listed
below:
1. Microsoft Dynamics™ GP client installation.
2. Crystal Reports 8.5 installation (This can be the CR 8.5 Professional or Developer Addition).
3. AnyView Client installation.
Once these required software packages are installed, this machine can be used to create Crystal Report
Web Gotos. You may choose to use several different workstations for administration. If this is the case,
each administrative workstation must meet the requirements listed above.
Browser Client Setup
The Browser Client is a workstation from which users will connect to the AnyView Browser using a
supported Internet Browser such as the Internet Explorer or Netscape browser. In order to view Crystal
Report Gotos, the Browser Client must have the required components installed.
1. A supported Browser installation.
2. A Crystal Reports Web Viewer installation.
The Crystal Reports Web Viewer is a Browser component downloaded to, and installed on, the client
machine that enables the client to display the requested report. By following the documented Crystal
Decisions procedures, the IIS Server can be configured to automatically download the correct Report
Viewer for the client’s browser. AnyView Browser uses two Crystal Reports Web Viewers.
Crystal Reports Active X Viewer:
This viewer is used for Internet Explorer Browsers.
Crystal Reports Java Plugin Viewer: This viewer is used for Netscape Browsers.

For Troubleshooting information regarding the Web Viewers, see the following Crystal Decisions
Technical Paper:
http://support.crystaldecisions.com/communityCS/TechnicalPapers/crystal_web_viewer_for_actx.pdf.asp

4

Note: All links to Knowledgebase articles, White Papers and downloads were valid as of the completion of this
document. Because of changes in the location of some files, some links may no longer be valid. Please contact
Crystal Decisions for the new location of any invalid links.
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Important Crystal Web Server Information
If you are creating Crystal Report (Web Server) Gotos, the path in which these files are stored becomes
an important part of the Goto Setup. These steps apply only to Crystal Report (Web Server) Gotos,
Crystal Report (ASP) Goto report files can be stored on any driver accessible through a UNC path.
In order to create a Crystal Report (Web Server) Goto, you must use the following procedure.
1. Create the Reports Folder
a. Create a sub folder named Reports as a subfolder of your AnyView Physical Directory.
For Example: C:\Accountable\AnyView\Reports
2. Copy any reports you wish to use for Crystal Report (Web Server) Gotos to this folder.
Once the reports are saved to the Reports folder, follow the Web Goto wizard to create gotos for these
reports.

Note:
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The installation of AnyView Browser does not install all of the files required to
display Crystal Reports in a web browser, but rather, installs only those files
required by AnyView. These files consist of ASP pages proprietary to
Accountable Software. and to AnyView Browser®. Accountable Software
does not provide support for Crystal Reports, Crystal Web Server
Components, Crystal Web Viewers or Microsoft Internet Information Server.
All support for applications not related to AnyView browser must be provided
by the Software developer.
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Report Publishing
Before continuing with the Report Publishing process, it is important that you meet the
requirements for the installed Dexterity version.
With AnyView Browser, files can be made available for viewing in your AnyView web application using the
Report Publishing functionality. **The content of these files can be generated from various sources
including Microsoft Dynamics™ GP reports saved to file, Microsoft Word documents Excel spread sheets,
Crystal reports, etc. These sources can be used to create files in a format supported by AnyView. Below is
a list of supported file formats.
Files formats that can be accessed through AnyView include:
Supported File Formats
.pdf
.htm
.html

Description
Adobe Acrobat Document
HTML Document
HTML Document

**While these applications can be used to create source files, only supported formats can be displayed in
AnyView Browser.

The Report Publishing Setup process includes the following steps:
1.
Create The Reports Folder to store the content files.
2.
Create Content Files, which contain the data to be displayed.
3.
Add the content files in the Report Publishing Maintenance window.
4.
Assign Report Security to allow users access to the reports.

The recurring processes of Report Synchronizing includes these steps:
1.
Update File Content.
2.
Update the Published Report Information.
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Create the Reports Folder
The Reports Folder is a folder or folders created to store the output files that will be published in AnyView
Browser. It is recommended that this folder be created as a Shared UNC path.
For installations that do not support (or specifically avoid) UNC paths, or for setting up a demo
machine, refer to the instructions at the foot of this page.
To avoid file access issues in IIS, it is recommended that these folders be created on the IIS Server,
which contains the AnyView web application. In order for IIS to display reports, it is essential that the
anonymous IIS user have access to the shared folder, which holds the reports to be published. For
information regarding UNC, Security and accessing files from IIS, please see the following references:
http://www.webopedia.com/TERM/U/UNC.html
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q207671
Microsoft Windows Help Topic: ‘Using Shared Folders’.
IIS Documentation Topic: ‘Anonymous access and authentication control’

Creating the Shared Folder and Granting Access to the Anonymous User
1. Using Windows Explorer, create a new folder on the drive where you would like to store files to be
published in AnyView.
2. Once created, right click the folder and choose ‘Sharing’.
3. Click the Share this folder radio button.
4. Enter a name for the shared folder, or accept the default.
5. Click the permissions button.
6. From Share Permissions, click the ‘Add’ button.
7. In the Look In dropdown list, select the machine name for the local server.
8. Add the name of your AnyView web application Anonymous User, and click ‘OK’.
9. **Mark the permissions options for the Anonymous User and click ‘OK’.
10. Click ‘OK’ from the Properties window to save and close the window.
You may wish to create multiple folders or sub folders in order to more easily manage published files.
Follow the procedure listed above to create additional folders.
** It is highly recommended that you grant only ‘Read’ permissions to the Anonymous User.
For Demo Machines and non-Shared UNC Installations
Some Dynamics installations either do not allow or specifically avoid Shared UNC paths. Likewise,
demo machines, when used offline (not connected to a network), do not utilize Shared UNC paths
predictably. Therefore, when implementing AnyView Report Publishing in these environments, it is
recommended that you use local paths when setting up Reports and Report Folders.
Typical UNC path to a report: \\MyWebServer\Reports\MyReport001.HTM
Typical local path to a report: P:\MyWebServer\Reports\MyReport001.HTM
To use local paths and files with AnyView Report Publishing, add the following entry to your DEX.INI
file:
ASILocalReports=TRUE
This will allow the AnyView Report Publishing Maintenance window to use local files.
This setting is not recommended for AnyView implementations where it is not a necessity, as it
requires that the workstations used to set up and run reports and the AnyView Web Server have
identical drive mappings to the report folder(s).
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Create Content files
Content files are the files created in a supported format, which will be published in AnyView. These files
can be generated from within Microsoft Dynamics™ GP, or may come from some other source, such as,
a Word document, Excel Spreadsheet, or a Crystal report saved as an HTML or PDF file. Once the
physical file is created, it can be saved into an AnyView reports folder. By enforcing a UNC path for each
file, any workstation that has AnyView loaded can be used to perform the setup and maintenance of
Published Reports.

Files can be created directly in the shared folder to avoid the additional step of moving them to the folder.
If you are publishing reports from Microsoft Dynamics™ GP, you can create a saved Report
Option, setting the File path in the Destination window to more easily automate the publishing
process.
This topic is covered in more detail in the Report Publishing Maintenance, Load Files section of this
document.
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Report Publishing Maintenance
In order to view files in AnyView Browser, you must add these files to the Reports Master list using the
Report Publishing Maintenance window. This window can be accesses from the Utilities >> Company
palette, by selecting entry ‘AV Reports’.

Print a list of all
Published
Reports.

Figure 69. Report Publishing Maintenance

Files can be added to the list using three methods. The first is to Manually Enter reports by typing or
selecting the path to the content file, saved in the shared reports folder. The second method is to use the
‘Load Files’ button to import files from a selected directory. The third method is to use the ‘Load Reports’
button to import Microsoft Dynamics™ GP reports that have been saved as Report Options.

Manually Entering Files
To enter files manually, enter the Report Title, and then type the path into the File Name field or use the
Folder Button to browse for the file. Once the file has been entered, you may also choose to enter values
in the UDF 1 and UDF 2 fields as well as enter Comments about the selected file. The Valid File
Checkbox, Run Date, Run Time, File Size and Published By fields will be automatically populated.

Load Files
The load files button opens a browse window, from which to select a path to the Shared Reports folder.
After browsing to the correct folder, click ‘OK’ to return to the Report Publishing Maintenance window. All
files in the selected folder that match the supported file formats will be added to the list. Once reports are
added, you may choose to change the Report Title, or accept the default, which is populated with the
Windows file name. The Valid File Checkbox, Run Date, Run Time, File Size and Published By fields
will be automatically populated.

A NYV IEW

Page 113 of 132

Accountable Software.

Load Reports
The Load Reports button opens the AnyView Load Reports Window.
Displays saved
Report
Options, which
have not yet
been added to
the Published
reports list.

Figure 70. AnyView Load Reports

The Load Reports window displays a list of all saved report options that have been created with a report
destination of ‘To File’. The Report Destination file selected in the Report Options Setup window must be a
UNC path in order for the report option to be listed here.
Creating Report Options is an excellent means of reducing the maintenance burden of report publishing
setup.
To add reports, mark the Include Checkbox for each report option you would like added to the list. Click
‘OK’ to return to the Report Publishing Maintenance window. All selected reports will be added to the list.
Once reports are added, you may choose to change the Report Title, or accept the default, which is
populated with the Windows file name. **The Valid File Checkbox, Run Date, Run Time, File Size and
Published By fields will be automatically populated if the file can be accessed.
**When loading reports, it is possible that the file does not yet exist. This report should be run, and the
Report Master list updated before viewing this file in AnyView Browser.

Terms
Valid File Checkbox
Report Title
Folder Button
File Name
UDF 1 & UDF 2
Comments
Run Date
Run Time
File Size
Published By
Include Checkbox
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Description
Signifies a valid File.
Signifies an invalid file.
The file name as you would like it to appear when viewed from AnyView Brower.
Opens a browse window to select the file.
Displays the path to the published file.
User Defined fields to group files or display additional information.
Field to store additional information about the file
Displays the last modified date of the file as displayed by the operating system.
Displays the last modified time of the file as displayed by the operating system.
Displays the file size in kilobytes as displayed by the operating system.
Displays the user who added the file to the published list.
Report Option will not be added.
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Report Security
Once files are added to the published list using the Report Publishing Maintenance window, permissions
must be granted to in order for users to view the files in AnyView Browser. Access to files can be granted
to users for each report in two ways: using Individual User and Report Security or Group Security.

Report Group Maintenance
In order to alleviate some of the maintenance burden created as a result off multiple users and file
combinations, Report Groups can be used to associate files into logical collections. The Report Group
Maintenance window handles this process. This window can be accesses from the Utilities >> Company
palette, by selecting entry ‘AV Report Groups’.

Print a detailed
list of all
Reports
associated with
the selected
group, or clear
the window to
print a list of all
groups and all
reports.

Figure 71. Report Group Maintenance

Create logical groups of reports by naming the Report Group, and entering a Description. Then add
reports to the group by entering the Report Title or using the Report Lookup button to select a report from
the Lookup window. The Remove Report button can be used to remove a selected report from the group.
This will not delete the report, but only exclude it from the group. Access to all reports in the group will
automatically be granted to all user members of the group. Once you have finished adding reports to the
group, use the ‘Save’ button to complete the changes.
*Reports can be associated to multiple groups. This allows users in two separate groups to access some
of the same reports without assigning individual access,
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Report Security By User
The Report Security By User window allows you to assign report and group security for users. Here, you
can grant user access to individual reports, as well as, add users to report groups. This window can be
accesses from the Utilities >> Company palette, by selecting entry ‘AV Report User Access’.

Print a list of all
Reports
accessible to
this user, or
clear the
window to print
a list of all
users and their
report access.

Print a list of all
groups the
selected user is
a member of, or
clear the
window to print
a list of all
groups and
their members.
Figure 72. Report Security By User

Report Access List
The Report Access List allows you to assign access to reports on an individual basis. To globally add and
remove the selected user’s access to reports, use the ‘Add All’ and ‘Remove All’ buttons. The ‘Remove
Report’ button will remove the users access to only the selected report.

Report Group Access List
The Report Group Access List allows you to assign report group access to users. To globally add and
remove the user’s membership in all groups, use the ‘Add All’ and ‘Remove All’ buttons. The ‘Remove
Group’ button will remove the user from only the selected group.
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Report Security By Report
The Report Security By Report window allows you to assign a user’s access on a report or group basis.
This window can be accesses from the Utilities >> Company palette, by selecting entry ‘AV Report
Access’.

Report
To set access to an individual report, select ‘Report’ from the Radio Group, then select a report using the
Lookup button. To globally add and remove the selected report’s accessible users, use the ‘Add All’ and
‘Remove All’ buttons. The ‘Remove User’ button will remove the selected user’s access to the report.

Print a list of all
users with
access to the
selected report,
or clear the
window to print
a list of all
accessible
reports and the
users who
have that
access.

Figure 73. Report Security By Report (Report)
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Report Group
To set access to a Report Group, select ‘Report Group’ from the Radio Group, then select a Group using
the Lookup button. To globally add and remove the selected Group’s members, use the ‘Add All’ and
‘Remove All’ buttons. The ‘Remove User’ button will remove the selected user’s membership in the
Group.

Print a list of all
members the
selected report
group, or clear
the window to
print a list of all
report groups
and their
members.

Figure 74. Report Security By Report (Report Group)
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The Reports Object
When AnyView is installed, a new object is automatically created. This object is named ‘Reports’. It is
created with a row level restriction by Login. This allows Reports object to display only reports to which the
currently logged in user has access.

Figure 75. The Reports Object

By Default, the Reports Object contains the Report Name, Comments, Last Run Date, Last Run Time,
and File Size Fields columns. **If you own AnyView Creator, you can modify the object to include other
columns. All of these columns can be used as you would columns in any other object, to sort, search, and
restrict your list.
** The File Name column, which displays the path to the file, was intentionally left out of the object. For
security reasons, it is not recommended that you include this column in any object that will be viewable in
an externally facing web application.

Internal SmartList Reports Object
If you own AnyView Creator, you can use the Reports object from the Microsoft Dynamics™ GP SmartList
to view reports. This object is created with a Goto, ‘View Selected File’, which will start the application
associated with the file, and load the file into that application.
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Viewing Reports
All of the reports listed in the Reports object in AnyView browser can be viewed in detail over the web. To
view a document, you can either double click on the record in the list, or highlight the row by clicking on it
once, then using the Web Goto button to open the document. The full document will be displayed with in
the browser using the default browser plug in for the selected file’s format.

Figure 76. Viewing the Document
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Report Synchronizing
Once the setup process is complete, the published reports will be viewable in AnyView Browser. As this
data is static, you will most likely wish to intermittently update the content of your published reports. This
can be accomplished using the following procedure:

Updating File Content
To update the content of your published reports, simply refresh the data for those reports. In the case of
Microsoft Dynamics™ GP reports that were initially published using a saved report option, re – running
that report option will update or append the data. In the case of reports loaded from a saved file, those
files will need to be manually replaced.
Once this is done, AnyView will display the new file content. However, the report information will not have
been updated. By report information we mean Last Run Date and Time, and the File Size. In addition,
should files have been removed from the folder, these would still be displayed as available reports in the
AnyView Browser Report Object. Should the user attempt to view a report whose file does not exist, they
would be presented with an error in the browser. To prevent this error from occurring, an to ensure that
the file information is accurate, you will perform the following process:

Updating File Information
In order to ensure that all of the file information is up to date for each published report, open the Report
Publishing Maintenance window after updating file content. This synchronizes the published reports with
their associated content files, updating the Last Run Date and Time, and the File Size. Any published
report which cannot be verified will be displayed with the ‘File Not Valid’ visual indicator in the Report
Publishing Maintenance window.
**It is recommended that this process be performed after each time a content file is updated to avoid
discrepancies between the displayed and the actual file information. However, the report will still be
accessible to the user, and when displayed, will show the updated content.

A NYV IEW

Page 121 of 132

Accountable Software.

AnyView Site Management
AnyView Site Management is a facility with which Administrators can close AnyView sites with a
customizable and informative notification to users and reopen those sites after maintenance has been
performed.
AnyView Site Management can be run on an AnyView Web Server by selecting
Start > Programs > Accountable Software > AnyView > Site Management
The AnyView Site Management window appears below.

Figure 77. AnyView Site Management

Options on this window can be selected from the Actions menu and include:
View Log (File > View Log)
This option allows you to see the log of previous actions performed by AnyView Site Management.
The log records operations that occur while opening or closing sites.
Clear Log (File > Clear Log)
Clears the log file.
Manage Sites (Actions > Manage Sites)
Bring up the Manage AnyView Sites window (described in detail on the following pages).
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Manage Sites
When you select Manage Sites from the AnyView Site Management window, the following window will
appear:

Enter the web server directory beneath
which exist the AnyView Virtual
Directories that you want to maintain.
This list will be populated with all AnyView
web applications under the specified
AnyView Parent Directory. AnyView web
sites are tested to find their current state.
You can select one or more Web Site(s)
to Open or Close by clicking the check
box(es).
Click this button to test the current state
of AnyView webs.
Text entered in this box will appear on the
web page users will receive when the
AnyView web has been closed. This can
contain plain text or valid HTML.
Close selected AnyView web sites.
Open selected AnyView web sites.

To close AnyView sites, perform the following tasks:
1. Open AnyView Site Management.
2. Select ACTIONS > MANAGE SITES.
3. Enter the web server directory beneath which exist the AnyView Virtual Directories that you want to
maintain.
4. Select the AnyView sites to close by checking them in the ANYVIEW SITES list.
5. Enter a SITE CLOSED MESSAGE to display to users when the site is closed.
6. Click CLOSE SELECTED SITES.
To open AnyView sites, perform the following tasks:
1.
2.
3.
4.

Open AnyView Site Management.
Select ACTIONS > MANAGE SITES.
Select the AnyView sites to open by checking them in the ANYVIEW SITES list.
Click OPEN SELECTED SITES.
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The Results
Closing an AnyView web site with the windows depicted on the prior page will results in users seeing the
following web page when they contact the AnyView web site:

Note that the Site Closed Message we entered on our Manage Sites window appears as nicely formatted
text on our “site is closed” page.
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How Do I Modify My Site Closed Page?
AnyView formulates its Site Closed page in the following manner:
1. It finds the file called ANYVIESITECLOSED.TEMPLATE.HTM in the AnyView web directory.
2. It gets the information entered as the Site Closed Message from the Manage Sites window.
3. It inserts that Site Closed Message into ANYVIESITECLOSED.TEMPLATE.HTM at the placeholder
labeled #SPECIALMESSAGE# and saves the result as ANYVIEWSITECLOSED.HTM.
4. When ANYVIEWSITECLOSED.HTM is displayed to the user, AnyView first applies the Style Sheet
and images used by the Login Page (as specified in ANYVIEW W EB PAGE SETUP).
You can modify ANYVIESITECLOSED.TEMPLATE.HTM using any HTML editor to customize it to the
look and feel of your AnyView site.

Testing Your Site While It Is Closed
A common desire of AnyView System Administrators is to be able to test their AnyView Site after
maintenance but prior to opening it to the general public.
You can access your AnyView site while it is closed to the general public by inserting a SITEADMIN flag in
its URL. For example, use something like this in your Browser:
http://mywebserver/myanyviewweb/default.asp?SITEADMIN=
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Technical Notes: What Does Site Management Do?
This section describes what Site Management is doing behind the scenes.
When you use Site Management and utilize the Manage Sites window to close or open sites, the program
performs the following operations:

Closing Sites


The program examines every directory beneath the specified ANYVIEW PARENT DIRECTORY.
Each directory is examined to see if it contains AnyView.INI. If it does, it is listed as an ANYVIEW
W EB. Sites are listed as closed if the file ANYVIEWSITECLOSED.ASP exists in the virtual
directory. It also checks to see if any users are currently logged into the web site.



The program elicits from the user the AnyView webs to close and the SITE CLOSED MESSAGE.



When CLOSE SELECTED SITES is clicked, the program goes through the list of sites selected to be
closed.



For each selected site, it finds the file called ANYVIESITECLOSED.TEMPLATE.HTM, inserts the
Site Closed Message, and saves the result as ANYVIEWSITECLOSED.HTM. It also copies the
file ANYVIEWSITECLOSED.TEMPLATE.ASP to ANYVIEWSITECLOSED.ASP.



It saves the SITE CLOSED MESSAGE to a file for later use.

Opening Sites


The program examines every directory beneath the specified ANYVIEW PARENT DIRECTORY.
Each directory is examined to see if it contains AnyView.INI. If it does, it is listed as an ANYVIEW
W EB. Sites are listed as closed if the file ANYVIEWSITECLOSED.ASP exists in the virtual
directory. It also checks to see if any users are currently logged into the web site.



The program elicits from the user the AnyView webs to open.



When OPEN SELECTED SITES is clicked, the program goes through the list of sites selected to be
opened.



For each selected site, it deletes the files ANYVIEWSITECLOSED.HTM and
ANYVIEWSITECLOSED.ASP from the virtual directory.
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AnyView Object Auditor
The AnyView Object Auditor provides AnyView Administrators with the capability to audit AnyView Objects
and Favorites for missing fields or tables. This capability is particularly handy when upgrading from one
version of Microsoft Dynamics™ GP to another, or when applying a service pack. Version upgrades and
service packs may include changes to the Microsoft Dynamics™ GP dictionaries and schemas in a way
that will cause AnyView Objects to fail. Examples include Favorites that search of fields that no longer
exist or Objects that reference tables that have been modified or removed from the product.
AnyView Object Auditor is started from Utilities > System >AV Auditor.

To use the Auditor, select an action (AUDIT
or REPAIR), select an Object or Objects to
examine, then click PROCESS.

Figure 78. AnyView Object Auditor.

Audit
The Audit option will report on the following problems with AnyView object definitions:





Incorrect Resource ID data for object tables.
Incorrect Resource ID data for object columns.
Object tables that do not exist in the schema.
Object columns that do not exist in the schema.

The Audit Report will recommend:




Repair option in Auditor for incorrect resource IDs.
Deleting object for tables that do not exist in schema.
Deleting column in Creator for columns that do not exist in schema.

Repair
The Repair option will fix:



Incorrect Resource ID data for tables.
Incorrect Resource ID data for columns.

If you have AnyView objects that contain external tables that are not in the Microsoft Dynamics™ GP data
source, make sure that the data sources are accessible to the workstation that is performing the audit.
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Appendix A: Modifying Detail Views
The intention of this appendix is to explain the elements specific of AnyView Detail Views. It is not a
comprehensive explanation of the HTML language. It is expected that users who intend to modify Detail
Views manually will have a detailed understanding of HTML.
Creating an AnyView Detail View results in the creation of an HTML template file that is then stored in the
AnyView IIS virtual directory. This HTML template is used to convert the output of the AnyView Drill
Arounds called by the Detail View into HTML content.
These Detail View HTML templates can be modified by using Microsoft FrontPage or any other HTML
authoring tool. By using such a tool, implementers can customize the look and feel of the Detail View by
moving data elements around on the page, editing the FormStyles.css style sheet, adding columns to
tables, and even creating formulas for calculated fields.

Before Modifying a Detail View
Before modifying any detail view, it is good practice to backup the HTML file you intend to edit. In addition,
understanding of the page elements and their use in AnyView is essential. Below is an explanation of the
Detail View HTML template elements.

Page Element

Description

<!--ASIDebugMode=OFF -->

Tag which determines how missing fields will
be displayed in the html page when requested
in AnyView Browser.

||BEGINSection|| and ||ENDSection||

Tags used to define the beginning and end of
a section.

||field name||

Tag to denote a drill around field that will be
replaced by data from the executed drill
around.

Prompt||field name||

Tag to denote the field label that will be
replaced by the Field Display name of the
column in the Drill Around.

Function(lsFunction =
Function Name ("||field name||","||field name||"))Function

Tag used to define a custom function. The
purpose of this function is to execute a
calculation producing the replacement value
for the function tag.

ASIDebugMode
The ASIDebugMode tag is useful when modifying and testing edits made to Detail Views. The purpose of
this tag is to provide an alert when a field name used in the detail page is not found in the source Drill
Around. By default, this flag is set to FALSE. In this state, any field displayed on the Detail View, but not
found in the source drill around will be displayed as a blank field. By setting this flag to TRUE, missing
fields will be displayed with the string “ERROR:Incorrect Field Name Not Found”. Where Incorrect Field
Name will be the field used in the Detail Page. To avoid seeing this message once the Detail View is
displayed, set the flag back to FALSE when modifications are complete.
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||BEGINSection|| and ||ENDSection||
The tags ||BEGINSection|| and ||ENDSection||, where Section will be the Section Name supplied in the
Web Goto Wizard, are used to identify each section of the Detail View. These tags are used by AnyView to
determine which fields are populated by each drill around associated with each section of the page. These
tags are created automatically by the Web Object Wizard, and must not be removed in order for the Detail
View to display correctly.

||Field Name||
The ||field name|| tag is used by AnyView to determine what elements of the template html must be
replaced by the literal values returned by the execution of the Drill Around. All fields to be replaced must
use the double vertical bar, ‘||’, beginning and ending tags. If you are moving fields in the layout, be sure to
move both the field name and these vertical bar tags.

Prompt||field name||
The Prompt||field name|| tag can be used in place of hard coded field prompt text. By using this tag,
replacing ‘field name’ with an actual field in the Drill Around, AnyView will replace this tag with the Field
Display Name used in the creation of the object. An example of when this might be used would be for
User Defined fields. By using the tag, AnyView will always display the User Defined prompt value stored in
Microsoft Dynamics™ GP.

User Defined Functions
A user defined function is a reusable block of VB Script code written to return some value based on
passed in variables.
For example, when creating a Detail View to display a purchase order, it becomes apparent that the tables
used to store Purchase Orders do not contain a Document Total field. By creating a User Defined
function, we can calculate this value and display it in our Detail View.
By default, AnyView includes several functions used in the Default Detail Views. These functions are
stored in the UserFunctions.inc file. This file is found in the AnyView Physical Directory.

Note:

It is recommended that you make a backup of the UserFunctions.inc file
before performing any modifications to the file. Also, be aware that changes
to any existing Functions may cause errors or inaccurate display in the
default Detail Views.

User defined functions are identified by the tag:
‘Function(lsFunction = Function Name ("||field name||","||field name||"))Function’
Below is a breakdown of each element of the Function:
Element
Description
Function(
The Required Start tag of the Function.
lsFunction =
The Required variable Result of the function.
Function Name ("||field name||","||field name||")
The name of the function as it was created in the
UserFunctions.inc file
)Function’
The Required End tag of the Function.
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As an example then, we will write a function to create a Salesperson name field in a Salesperson Detail
Page. Because the salesperson name is stored in three separate fields in the Salesperson Master table,
the wizard will insert them separately in the Detail View. To create a more pleasing layout that displays as
“Last Name, a comma, First Name, and Middle Name”, rather than displaying those fields separately, we
can use a function.
This example assumes that an object for Salesperson, a Drill Around for that object and a Detail View
have been created. We now want to edit the created HTML template to display the salesperson name. In
order to do this, when creating the Drill Around and Detail View, be sure to include the fields required to
create the name field.
Listed below are the steps to create this function and add it to the Detail Page.
Backup the UserFunctions.inc file.
Open the UserFunctions.inc file in a text editor such as Notepad.
Scroll to the bottom of the file, and enter your text just above the close script tag “%>”
Enter the Function Name, for example:
Function SalespersonNameDisplay()
Close the function with:
End Function
Now, add names for the variables needed for the calculation. In this case, Last Name, First Name, and
Middle Name. With the variables added, our function will now read:
Function SalespersonNameDisplay(inLast,inFirst,inMiddle)
End Function
We can now begin adding the logic for the function. Our intention is to output a string formatted as
mentioned above as the return of the function, so we add the lines:
If inMiddle = “” then
SalespersonNameDisplay
Else
SalespersonNameDisplay
End If

= inLast & “, ” & inFirst
= inLast & “, ” & inFirst & “ “ & inMiddle

The final completed function then appears as:
Function SalespersonNameDisplay(inLast,inFirst,inMiddle)
If inMiddle = “” then
SalespersonNameDisplay = inLast & “, ” & inFirst
Else
SalespersonNameDisplay = inLast & “, ” & inFirst & “ “ & inMiddle
End If
End Function
When the function is complete, save and close the UserFunctions.inc file. We can now add the Function
to the Detail Page.
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To use the new function in the Detail page, follow these steps:
1. Backup the Detail Page.
2. Open the page html page in an HTML authoring tool.

3. Find the section that contains the Salespersons First Name, Salespersons Last Name, and
Salespersons Middle Name fields.
4. In the section of the page you want the new field displayed, in place of an existing field such as
the ||Salespersons Last Name||, enter the function tag:
Function(lsFunction = SalespersonNameDisplay(
“||Salespersons Last Name||”,
“||Salespersons First Name||”,
“||Salespersons Middle Name||”))Function
5. You would now remove the tags and rows for the Middle and Last Name fields, and change the
entry Prompt||Salesperson Last Name|| to simple “Salesperson Name”.
6. Save the HTML page.
Now, when this Detail View is displayed in AnyView Browser for salesperson Charles Erickson, instead of
seeing:
Salesperson Last Name
Erickson
Salesperson First Name
Charles
Salesperson Middle Name
David
The display will be:
Salesperson Name

Erickson, Charles David

Modifying Styles
As a means of editing the visual characteristics of the Detail View such as the font colors and styles, the
background colors and other visual elements, you can edit the FormStyles.css file found in the AnyView
Physical directory. When applying section styles in the Web Goto Wizard, each element’s style is set with
tags such as:
class=”Form-HeaderPrompts”
class=”Form-HeaderData”
class=”Form-FooterPrompts”
class=”Form-FooterData”
class=”Form-TableHeader”
class=”Form-TableContent”
Each of these styles represents a class in the FormStyle.css file. By modifying the properties of the
elements of the class, you can make global changes to your Detail View appearance.

Note:

A NYV IEW

It is recommended that you make a backup of the FormStyles.inc file before
performing any modifications to the file. Also, be aware that changes to any
existing styles will affect the default Detail Views appearance.
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Appendix B: AnyView Browser – Dependency on GPCONN.DLL
rd

Beginning with the Dynamics GP 9.0 Release, Microsoft has prohibited 3 party products such as
AnyView Browser from decrypting the SQL passwords of Dynamics GP users. Instead, They have
provided a new component that can be used to obtain a direct connection, and indirectly validate the SQL
user and password. This component is normally installed by the Dynamics GP client installer, into the
folder:
C:\Program file\Common Files\Microsoft Shared\Dexterity\GPCONN.DLL

The AnyView Browser Web Server Components depend upon this DLL for proper operation, so the
AnyView WEB Components installer will install a copy of this DLL to the Windows System Folder on the
Web Server. If you also have a Dynamics GP client on the Web Server you may wish to delete this file in
the Windows System Folder, and re-register the latest GPCONN.DLL installed by Dynamics GP, using a
command similar to:
Regsvr32.exe “C:\Program file\Common Files\Microsoft Shared\Dexterity\GPCONN.DLL“

Security and Permissions needed to run GPCONN.dll
Under some conditions, you may be presented with a login error which references this appendix the first
time you attempt to log into the AnyView Browser Web Site.
The GPCONN.DLL, provided my Microsoft Dynamics GP, makes use of several Windows Cryptography
API’s that require Interactive User Permissions to certain Windows Files in the Documents and Settings
folder.
If the GPCONN.DLL fails with an Error 70, Permissions Error, then the current user that the IIS process is
running under, does not have read access to the needed files. This error should not occur in the normal
operation of AnyView Browser, but if it does, one can determine the file that needs to have permissions
modified, by running the “Filemon” utility made available at www.sysinternals.com. This small utility, when
run on the IIS Server, allows one to trace all file open attempts. By setting the restriction filter to a string
such as *crypto*, you will be able to see the file that the process fails to read, when the user attempts to
log into AnyView Browser.
A typical File that will need to have read permissions granted on it, would be:
C:\Documents and Settings\All Users\
Application Data\Microsoft\Crypto\RSA\MachineKeys\
fc1e3851f429ea606d6ff1e01a5229f1_7b71fbce-dff3-42c2-9259-d2367eb8daa9

(The File name is a long string of characters in the form of a Globally Unique Identifier string)
By using Windows NTFS Security to “Take Ownership” of this file, An Administrator can Grant Read
permissions to IUSR_Machinename or another user if a specific user is used in the IIS Anonymous
Authentication User setting in the Directory Security Tab of the AnyView Virtual Directory in the IIS
Manager Control panel applet. This action should eliminate the error.
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